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® Names and Logo are registered trademarks of Narda Safety Test Solutions GmbH and L3 Communications Holdings,
Inc. — Trade names are trademarks of the owners.

Before using this product, the related documentation must be read with great care and fully understood to familiarize
with all the safety prescriptions.

To ensure the correct use and the maximum safety level, the User shall know all the instructions and recommendations

contained in this document.

The information contained in this document is subject to change without notice.

KEY TO THE SYMBOLS USED IN THIS DOCUMENT:

& DANGER

A WARNING

& CAUTION

NOTICE
@TE

The DANGER sign draws attention to a serious risk to a person’s safety,
which, if not avoided, will result in death or serious injury. All the
precautions must be fully understood and applied before proceeding.

The WARNING sign indicates a hazardous situation, which, if not avoided,
could result in death or serious injury. All the precautions must be fully
understood and applied before proceeding.

The CAUTION sign indicates a hazardous situation, which, if not avoided,
could result in minor or moderate injury.

The NOTICE sign draws attention to a potential risk of damage to the
apparatus or loss of data.

The NOTE sign draws attention to important information.

II' Notes and symbol
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1 — Installing the program

1.1 Introduction Technological advancements and the increasingly widespread use of
electronic equipment for telecommunications, data processing, industrial
automation, etc. have led to a growing new field: electromagnetic
compatibility (EMC). Because many devices work in close contact with one
another, they can generate electromagnetic interference and may therefore
work less effectively. The PMM Immunity Test program will check for this
on the basis of your equipment, setup and operating procedures.

1.2 Hardware
requirements

Pentium Il processor

At least 256 MB RAM

At least 50 MB free hard disk space

USB or RS232 port (or Bluetooth with optional adaptor)
Windows™ 2000/XP/Vista operating system

@ Updates can be downloaded from www.narda-sts.it or obtained
NOTE directly from our sales department.
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1.3 Installation The program has to be installed on the hard disk before using it.
Go to My Computer, browse the Software Media and double-click the file
PMM Immunity Suite Setup.exe.

52 PMM Immunity Suite Setup

Welcome

Welcome to the installer for PMM Immunity Suite 1.00.

Itis strongly recommended thatyou exit all Windows
programs hefare cantinuing with this installation.

Ifyou hiave any other programs running, please click
Cancel, cloge the programs, and run this setup again.

Otherwise, click Mextto continue.

P Trmmunity Suite!
e BEUR

You can exit the installation by selecting Cancel. The following
confirmation message will appear:

r;u PMM Immunity Suite Setup

J

[ cancai

II' Installing the program
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@ In Windows Vista, most programs are blocked to protect your
NOTE computer. To start the installation, you may need to allow the program
to communicate.

Controllo dell'account utente =
@ Tentativo da parte di un programma non identificato di accedere al computer

Utilizzare il programma esclusivamente se |o si & gia utilizzato in precedenza o se ne conosce la
provenienza,

E WinBB30 . exe
Autore nen identificato

=+ Annulla

La provenienza o lo scopo di queste programma sono sconosciuti,

<+ Consenti
1l programma & attendibile. La provenienza € nota ed & gié stato utilizzato in precedenza,

"‘:’.' Dettagli

Controllo account utente consente di bloccare le modifiche non autorizzate al computer,

The program will ask you to confirm the installation folder. Choose Next
to confirm the default directory, or Change to select a different folder.

£ PMM Immunity Suite Setup E'

Installation Folder
Vwhere would you like PMM Imimunity Suite to ke installed?
— e

The software will ba installed in the falder listed below, To select a different location,
either type ina new path, or click Change to browse for an existing folder,

Install P Immunity Suite to;

CAPragrammPM Immunity Suite | [ Change... ]

Space required; B:29 MB
Space availakle on selectad drive: 68.92 GB

Sfoglia per, cartelle

thsslbation Install WIREP&0D to:
Where would
@ E_)esktop
The softwa # ) Documenti ent location,
aeither type | &2l J Risorse del. computer I
[+ %4 pisorse direte
Install WinH

C:AProgra Change...

Space reqgu

Snace availl

Cartella: ! Dacument |

Crea nuova cartella] [ (814 _] [ annulla ]

Installing the program III
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The software is now ready to be installed. Click Next to continue the
installation.

% PMMm Immunity Suite Setup

Ready to Install
ol are nowe regdy to install P Immunity: Site 1.00
s c—————t]

The installer now has enough infarmation to install MM Immunity Sdite on your
computer.

The following settings will he used;

Install folder: CARrogrammiPhM Immunity Suite

Shortcut folder, Pl Imimunity Suite

Please click Mext to procesd with the installatiorn.

A status window will appear, showing the percentage of files copied into
the specified folder.

B PMM Immunity Suite Setup

Installing PMM {mununity Suite

Please wait. .

Installing Files...
CAProgrammitP b Immunity Suitelicon'LogoMarda.ico

Installing the program
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Once notified that the installation was successful, click Finish to
complete the process. The folder PMM Immunity Suite will be created in
your Programs folder.

58 PMM Immunity Suite Setup

Installation Successful

The PN Imrnunity Suite 1.00 installation is complete.

Thankyoufor choosing P Immiunity Suitel

Please click Finish to exitthis installer.

iish

A shortcut will appear on your desktop to allow easy access to the
program.

7]

PRMImmunity Suite;

Installing the program III
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1.4 Removal

The recommended procedure for uninstalling the program is as follows:
Disconnect the devices attached to the computer. In Windows XP, click

Start (in Windows Vista click the @) then All Programs, place the
cursor on PMM Immunity Suite, and click Uninstall PMM Immunity
Suite.

f&@ Programm R P Tty Suite B8 PrMImmunitySuite
I
4 Dati recenti ;m Lninskall PMM Immunity Suike
-
O mmpostazioni

,:J Cerca

¥) Guidainlinea e supporto tecnico
= Eseqgui...

7] Disconnetti mirka, ..
8] chiudi sessione. ..

The program can also be uninstalled using the Control Panel.

@TE Use this method if the Uninstall option is not available from Start -
> All Programs.

Disconnect the devices attached to the computer. Click Start, Control
Panel, Programs and Features (in Windows Vista). Select the program
from the application list and click Remove.

B8 PMM Immunity Suite

Fate clic gui pe

er fimueyiers il programma dal carmpute 50, scedliersRimuayl " i
Per rimucvers il programma dal camputer inusa, scagliers Rimayw Hirnlia

Follow the instructions displayed on the screen.

AWARNING When you are prompted to remove shared files, select No. If these
files are deleted, other programs that use them may not work

properly..

Installing the program
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2 — Run the program

@ Before running the program, we recommend limiting the number of
NOTE applications in use.

You can now start the program using the desktop icon.

or, from the Windows XP Start button, selecting All Programs->PMM
Immunity Suite->PMM Immunity Suite.

fﬁi -Programmi

l_.:} Dati recenti 4 %, Uninstall PMM Immunity Suite
[} Impostazioni 3

& Lerca 4

&) Guida in linea & supporto becnico

|“=F Esequi...

|Z] Disconnettimirko...
(8] chindi sessione...

In Windows Vista, click the Windows icon (@ ), then All
Programs->PMM Immunity Suite->PMM Immunity Suite.

The title screen appears:

/A nharda

Safety Test Solutions”

ar {B Coanmric:lios Cornparyg

P

Immunity Suite

Document PMMISEN-71003-2.16 — © NARDA 2017
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2.1 User interface The title screen is followed by this interface:

1—»

The interface contains:
1. Title bar

2. Menu

3. Selection buttons
4. Main window

These are described in greater detail below.

II' Program lunch
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2.1.1 Title bar

From left to right, the title bar presents the icon, the name of the
program, and its release. The date and year of the release are shown in
parentheses.

*' PMM Immunity Suite Rel. 1.03(1109)  [Z|B|X]

The window control buttons (minimize/maximize/close) are also available.

If the main window is minimized, the information will be displayed on
the Windows taskbar at the bottom of the screen.

B T

The program can be closed at any time, and the following confirmation
message will appear:

3/ Wiould you like to exit ba the Immunity Suike?

L Si ] [ Mo J

Program lunch III
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2.1.2 Menu The main menu contains these commands:
File ? - File:
- ? (Info):
2.1.2.1 File The File dropdown menu includes:

- Open: Opens a new work session in Radiated or Conducted or

" PMM Immunity Suite Rel. .
Automotive mode.

Cpen ’ ' PMM Immunity Suite Rel. 2.05 (06/11)
Mews Automotive Key Code = 7
Exit Open Radisted  CTRL4R
| ) Conducted  CTRL+D
Mew Automotive Key Code utomotive CTRL-LM
Exit |
|
- New Automotive Key Code:
- Exit: Exits the program at any time (subject to confirmation):
2.1.2.2 ? (Info) The ? dropdown menu includes:
n - About: Information on the program creator and customer support.
.;!'.I:uzuut
' Press &4l to close the window

' About - PMM Immunity Suite v1.00

narda

Safety Test Solutions®

s

an (B Communications Company

A

Internet aike Cuztomer Support

www.narda-sts.it support@narda-sts.it

| bout |

Ahok

Program lunch
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2.1.3 Selection buttons A new work session can also be opened using the selection buttons under
the main menu. The third button activates the Editor.

| IR | C | R
- Select to open a new session in Radiated mode.
- Select . C to open a new session in Conducted mode.
- Select A to open a new session in Automotive mode.
ﬂ 2| .
- Select ..===.. to open the Editor.
Detailed instructions for the different modes are provided below.
2.1.4 Main window The main window displays the active work session or editor session.
R d' t d d ' Ph Irsmunity Suite - Radiated {IEC 6700043 )
adiated mode | e e (TS
oy . 80.000
5 e —
‘ i e —_—
; . —
________________ | Measure
Selups 1 Companants I Seftings .m
@ IEC 61000-4-3 O E01-384 ) He Compliam
e
Exit
Conducted mode . P Imunity Sulte - Cenductad
" i 80.000
— —
I Pﬂ::‘:::il.l ]I
AE DN ot Clamp EU o
[ X | Meassre
Setups 1 Componirit 1 Sulings m —
& EC 6100045 I
(Z) CON/Clagy et
3 Clamp = Cunent probe Statis
Exit

Program lunch III
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" PMM knmunity Suite Rel. 2.06 (10/12) - [Automative]
—
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[-D)%)
L - X
A 3
Setup table | Meamn
) Ecll Lkl {Z) Miskn mdormate: Lable
M
s Hore =
s —
HI " o
Gerein Swtca || Pase |
| M‘ e o
- | - weeeee MHZ
T -0 9%, cuin® | > ——dBm
\ R D Conpler
EERDUALT “":" A
i
Forward
M, e g—
i 2 Fevere
ESICE FEmE] —dBm
Senups 1 Companents 1 Settings
150 11452 - 4 150 11452 -5
Status
(o] 1]
3 B + Cument Probe Exit

)

' Editor [ Untitled ]

EHE&g 94 HB B r U s @

| [@erial Unicode M5 v || |8

1214

1021142009

See below for further information on these windows

Program lunch
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3.1 Introduction to
Radiated mode

ek

] Conducked
Exit

L

R

3 — PMM Immunity Test
Radiated

Radiated mode tests your equipment's immunity to the magnetic fields
produced by radio transmitters or any other device that emits radiated
electromagnetic energy. This kind of radiation may be generated by
portable transceivers, base stations, television transmitters, radio
transmitters, and other electromagnetic or intermittent sources. To obtain
reproducible results, the test should be performed in an anechoic
chamber; the standard for equipment, setup and procedure is EN 61000-4-
3.

Loading Radiated Module

{ IEC 61000-4-3 )

TN Y ‘

SINTE

[5E5

1 P e
[@ R 9 1hle

Ser “=hle

0

<
Fover Meter

Generator | I
i | FIERe] |
i |
Lﬁ ij ' '
Amplifar ‘I d | |
i il A l" I
= = RBF Dir, Coupler ud H i
|
| '
|
| i
| e |
Setups Components T Settings T
Measure Break points T Charts! I
Graphtype Chart Reference Reterence\Rangs dbm
Linear BackColor [ ] O] Lew [ o] Range [100 |
Grid Color [ — — —

Break points
Color Trace

Curzor

Generator [l |~ - --<ard PN
Color = Field meter [ Reverse P I |evel i) Range ;10 "7. Exit

ReferencetRange Y/m

Fig. 3-1 Main window - Radiated
This window contains:

Menu

Diagram window
Function tabs
Setup table
Measure

oD~

Document PMMISEN-71003-2.16 — © NARDA 2017
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3.2 Choosing the Once Radiated mode is launched, the compliance standard needs to be

compliance standard chosen. The program offers a selection under the Setups tab.
(Setups)

- EN 61000-4-3

- 801-3-84

- No Compliant

Setups T Cormponents T Settings
@ IEC 61000-4-3 © 801-3-84 ) No Compliant

() 16 points - 75%

) 4 Paints - 100%

[ 32 | Radiated
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3.3 Equipment selection  After selecting the compliance standard, choose the equipment to be used
(Components) during calibration or testing.

The program divides equipment by type; for your convenience, drivers
from the PMM family can be used.

To enable the desired module, double click the corresponding line (a
will appear next to the instrument selected).

- Generators: Lists the available field generators

Generators! T Power Meters T Field Meters T
Buz |Comm,| Startfreq. | Stop freq. | Minlevel | Mas level
il Eame Bustyoe| 5 pat | aHa | MH2) | (dBm) | (o)

DUMBY GEN GFIE S i 0.01 20000 100 20
Pri 2000 R5232 S 3 0.01 1000 -20 10
PriM 203085 R5232 s 1 0,009 3000 107 10
W PriM 3030USE | LISE ks b 0.003 3000 107 10
F'MM. ?!D'I OUsSeE LSB S * 0.009 1000 07 10
Pk 30T0RS R5232 S 1 0.005 1000 107 10

- Power Meter: Lists the available power meters

Generators T Power Meters! T Field Maters
Selected Marie Buz type aEdLul:ISr. E;gﬁn' St[‘?‘;tl_:r:]q' St[':r'_‘!,l:'l_:r:]q' M[Igé?_:]d MFJE';T'
DURKMY P LISE 0 1] om G000 -40 an
Frikd EE3D  LISB 0 0 0.003 3000 -40 30
W DUAL BE3D  LISE 0 0 0.003 3000 -40 30
Pritd BEOD  R5485 1 1 0m 1000 -40 27
DUAL BEOD R5485 1 1 0m 1000 -40 27

- Field Meters: Lists field probes, optical repeaters and field meters.

Generators T Power Wetars T Field Meters!
Selected Marne Buz type aBdLuiISr. E;;nr?' Probe name Stﬁ;tl_flge]q' St[?‘!i:u'_fllze]q. ME,G};\;EI MR::J;\]WEI
DUMMY FM | GPIE 0 0 0.m 10000 i 200
i Pt EPEOT  R5232 0 5 | Pt EPED 0.m 9250 05 500
P ORO3  R5232 0 5 PM EP330 01 3000 0.3 300
P 8053 R5232 0 § P EP330 01 3000 03 300
Pt EPEOD | RS5232 0 5 | PrM EPEO0 01 9250 014 140

- Others: Lists the amplifier, directional coupler, TEM cell or GTEM

antenna .
Generators T Power Maeters T Field Meters T iOthers!
RiF Direchonal Coupler Test Erwviroment TEM/GTEM Amplifer
Forward Coupling | 40| dB Septum distance _'I_._l]_l-]_l]: m Name PMM GIJDIJN

From this tab, you can set the coupling factors of the directional coupler,
the septum distance of the TEM or GTEM (if any), and the name of the
amplifier used.

Radiated [ 33 |
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@TE

Radiated

Additional devices can be added to each of these tables by right-clicking

and selecting Add

new.

Generators! T Powar Meters T Field Metars T_
Selected Mams Bus type aBdLéS:. EEE:T' St[ar:rllt'_flrze]q. St[orlll:u'_flrze]q. MEE&?_:?' M?;Blﬁq\]@

DUbbY GEW  GPIB w0 om 20000 -100 20

Pt 3000 R5232 Add new 1000 -B0 10

Fhd 3030RS  AHS232 3000 -107 10

ki Fhdtd 303005B  LISE 3000 107 10

Pt 301005B  USE 1000 07 10

Fhib 3010RS  R5232 ; 1000 107 10

Check Device

Immunity Suite - add Generator

Instiuments name
Instr. driver name

Instr. bran

Bus type

Com Port num,
Freguency range

From
Lewel limits

From |

(1]

[{1]

Bus Address

Sawve Cloze

| MHz

| e

m

Devices can also be checked, modified or removed by right-clicking from
the corresponding line:

Generators T Fower Meters T

Selected tame Bz type aBdLéSL E;;n[:n. St[.?\:lll_:rze]q. St[il,l:
DUMMY GEN GPIE A a om 20
Frdtd 3000 R5232 A 3 om i
PMM 3030RS  RS232 A 1 0.003 30
VoBNGEEOSE T, Y r | oms | X
Frdbd 3070USE ModiFy i 0.003 1
Ph 3010RS 0.009 10
Remove —

Check Device

For connecting and setting the COM port of fiber optic
equipment, see the user manual supplied with the device.
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- Modify: changes the properties of the device.

Immunity Suite - add Generator.

Instruments naime [Pt 3030U5E |
Instr. driver name [PMmM3030U |
Bus type !USEI v

Freguency range

From | oooa| te | 3000] MHz
Level limits

From | 07 te | 10| aBm

- Remove: removes the device and its driver from the list.

- Check Device: makes sure the driver is working and the device is
properly connected. This option is only available for the device selected (V).

If the device is connected and the driver has been correctly installed, the
following message will appear:

PiM 3030058

i

Driver best.....Driver works correctly
Device best, ., ... Device Ok

This message will appear if the device has not been connected
properly to the work setup

PiiM EPS01

Diriver kest L Driver works correckly
Device test..... Error during Device test

Q

If the driver of the device has not been installed properly, the screen will
show:

PMM3030U

@ DDE Driver not Found

PMM 3030058

Q

Instruments comunication erroris occurred.
Test will be aborted

We recommend performing a device check before starting the
calibration phase or immunity test. In any case, before calibration or
testing, the program runs an automatic check and reports any errors as
described above.

[ s 1]

Radiated
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" PMM Immunity Suite - Radiated

( IEC 61000-4-3 )
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The diagram window shows the setup to be followed on the basis of
the compliance standard and equipment selected.

i e,
PN ‘
AT
SUITE
L\ |

Power Meter

DAL BE20

Generatar ] !
VL EMRERR |
|
Amplifer i I
g 408 00 |
; ] l | RF Dir. Coupler D '
’ |
|
e e e e e e R A |
Setups T Components T Settings
Generators I Power Meters T Field Meters T Othars
Bug |Comm.| Startfreq | Stop freq | Minlevel | Max level
SE'EC‘Bd‘ Name | Busbpe) sy | “pott | ~IMH2) ‘ MHz) | (dBm) | ()
DUMMYGEN | GPIE | % 0 | 00 20000 | 100 20
PMM 3000  RS232 | x| 3 | 001 | 1000 80 10
PMM3030RS  RS232 | % | 1 | 0003 | 3000 107 10
Y PMM3030USB (USB | X | X | 0009 | 3000 107 10
PMM3010USB (USE | = | X | 0003 | 1000 107 10
P 3010R5  RS232 # 1 0.003 1000 107 10

The selected devices (V) are shown at the bottom of the panel.

In addition to using the Components tab, you can move from one type

of equipment to another by clicking the label with the device's name

Radiated

PRI 3030USE

| in the diagram window.
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3.5 Settings

After performing the setup shown in the diagram window, the calibration
and test parameters need to be set using the Measure tab:

Setups T Components 1 Settings I
Measure 1 Break points T Charts
Frequency Lavel - —
Start [ 80.000] MHz Limit [10 ~| Wm Dwelliime | 1000.0] ms
Stop | QEE_D_Dl MHz Tolerance IR Measures Power/field
Step I71_ % W odulation O dBm @ VWim
[ﬁ] | ] ..-_\.-.;.-: WiH Type OFF | Multiscan

Step percent

The Multiscan feature allows you to modify measurement parameters
within a given frequency range.

Immunity Suite - Radiated - MULTISCAN Setup

MultiScan Options

Stat|  Stop | Step | Dwell| Modulstion | Depth  Table Name | level | LW
MHz MHz b 4 ms b4 W¥im MHz

[ 27 ||| 500 | ‘ [(1] ‘ [1000] ‘!DFF ¥ [ 80 ‘ [ble_80_30 | ‘ [10 & | [1[ 900 ]
| | | | 2 e | e
| ] w| [ || [wesoso o] [ O] |
I o v N = .
[ — o[ ||pesoso o[ wl|Ol |
| | 2 e |
C vl [ |pesoso v |[ w0 |
| | | v [ ||mesos o] [ S|O] |

CW Dwell Time [sec] | 30 | Close |I

Radiated 3-7
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With the Break points tab, you can set the frequencies at which
measurement will be temporarily suspended to allow a change in

setup.
i Measure T T Charts i
_F}e‘;--Mﬁi | Comment
Stop 1 [ 22 ] l Cambia Amplificatare
Stop 2 , [ 32 || _E_an-n-l.a_i;a.&hﬁiifi.catore
(o0 ]| |
[ stopa || [
Stop 5| 1]

Each time the stop frequency is reached, a message will display the
scheduled action.

Break point 2 @

LS
"!r) Cambia Amplificatore

Click OK to continue measuring.

The Charts tab allows visual modifications to suit your preferences.
For each element, click on the color shown, and change it using the
Windows color box if desired.

In this tab, you can also move the reference level along the y-axis (+ and -
buttons), or change the power level and range (in dBm) and the magnetic
field range (in V/m).

[ Setups T Components T Settings ]
Measure T Break points T E
Graph type Chart Fieference ReferencetRangs dBm
Lineat BackColor [ | [+ ] [—l Level | o0l Range [100 |
Grid Color [ — - -
Break pointz

Color Trace
5 ] Forward P
Cursor Generator I 15 1 ReferencelRange Vdm

Color ] [#] Field meter [ [ Reverse PM I javel 3 Range' 0 |

Radiated
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3.6 Settings management For each new session, the default file RadDefault.tst is loaded.
To avoid having to re-enter preferred settings, they can be saved in a single

tst file:

Open sekting Chrl+O . . . L .
| The command File -> Save setting overwrites the file in use. If no file was
Save sething Chri+5 called up when the program was opened, the default file will be
Save setting as... Cir-A | overwritten. The following message will appear:
Display k
- PMMImmunitySuite
Exit Chrl+s

\}3) The settings file will be changed, are you sure?

Si | Mo

Choose YES to overwrite the file in use. Choose NO to cancel the
operation and return to the main window.

File -> Save setting as... Enter the file name assigned to the work

session and press Save.
i ; LJ Salva |
Salva come: | Fradiated Immurity Settings Files [ T5T) x| Annulla

Mome file;

The file can be called up at any time with the command File -> Open
setting.

Radiated Immunity Settings File Browsing & Opening

Cercain: |;) War _..J & I‘:j{ -

_J '@ RadDefault kst

& settings_sn_s0.757

Deskiop

LY/

Documenti

Rizarze del
computer

‘Q Maome file; || l] Api |
Risoree ditete  Tipo file: | Radiated Immunity Settings Files [ T5T) x| Binnulla

I Apiiin zola lettura

File -> Display -> Default colors is used to restore the original display.

Radiated
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3.7 Setup table You can now calculate the levels assigned to the generator in order to
have a constant field value within the chosen frequency range.

There are different ways to create the table:
- Automatically (select Make automatic table)

- By adapting the automatically created table to the instrumentation used
(select Edit table)

- By completing the entire table manually (select Edit table)

3.7.1 Automatic table
creation

B

" PMM Immunity Suite - Radiated { IEC 61000-4-3 )

Setup table Measure
40.00 14,0
) Edit table ) Make autdmatic table
30.00 13.0
20,00 12.0 i | D
|Comment
10.00 1.0
0.o0 10.0 L
= | O Const Field methad O Corst Pawer method
j-'r: 10,00 90
i'-;'-j = I Yiew Data ] [ Start Test ] [ Pause. ‘
20,00 2 Generatar
000 7.0 I MHz |
® dBm |
-40.00 B0
Field Meter
000 50 & - Vim |
000 40
a0.0 2.0 2.0 830 4.0 85.0 860 ava 880 g9.0 0.0 S
MHz @
Setups T Camponents T Settings 3
Measure T Break points T Chartst
Graph lppe Chart Rieference Referance\Range dBm
Linear BackColor [ | Level 0| Range [100 v ;
- Grid Color [ E] . :
Break points
Color [ Trace Status
Curzor Generator: Forward PN - Feference’R ange V' /m
Tolar ] Field meter [ ReversePM M jevel | 10| Range [10 v Exit

Radiated
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To create a table automatically:

- Select Make automatic table

{3 Edit table ) Make automatic table

Select [:J , assign a name to the table and press Save

L

Norme file: tatule 8080 lJ Salva |
Salva come; |Table Files [* Fac) LJ Annulla

If an existing table is selected, the following message will appear:
Save FILE TABLE as X

'E CiiProgrammitPMM Immunity SuiteyCalibrationsitable_50_90.FAC esiste gid.
-

Sostituirlo?

Choose YES to overwrite the table.
Choose NO to cancel the operation and return to the main window.

- A comment can be added, if desired.

- Calibration can be performed using the constant field strength method
or the constant power method (consult EMC regulations for further
details.

) Const, Field method 3 Const, Power method

- Press Start test, then Abort test if you wish to terminate the process at
any time.

[ Start Test ‘ N [ Ahort Test l

A Pause button is also available, and becomes Continue to resume the
process.

[ Fauze l N [ Continue |

Once the calibration has begun, a message will appear stating that the limit
will be multiplied by 1.8 as required by EMC regulations.

PMMImmunitySuite

Be aware set limit will be multiplied by 1.8 during calibration,

Radiated [ 311 |
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The Generator window shows the level (in dBm) entered by the
generator, at a given frequency (in MHz), to generate the chosen magnetic
field level.

-Generator

| 85.770820 MHz |
® -32.4 dBm |

The color of the dot corresponds to the color of the line on the graph.

The field level generated inside the cell is displayed in the Field Meter

window.
Figld Meter Field Meter

o azvm | o ISR

Values outside the selected tolerance will be shown in red; the
generator will adjust the level to bring the magnetic field back into
range. The color of the dot corresponds to the color of the line on the
graph.

View Diats |

table form

40.00 260

30.00 240

2000 220

1000 200

ooo 180

1000 ws.né

=

dBm

-20.00 140

-30.00 120

-40.00 oo

5000 g0

-E0.00 =1}
an0 a1.0 20 530 840 50 860 qr.0 a0 8a.0 0.0

MHz

Meaziiie

Frequency | Paoints1 | Points2 | Points3 | Points 4
800000} 328 | -
808000) 328 | -

816080} 328 |

2421|327

832483 326

B40B0BF 328 |

B49216) 326 |

857708 326

BE.6285

574548

38,3698

89,2535
900000

Radiated
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Because the immunity test is only valid if there is an area within the
shielded chamber where field uniformity complies with the standard, the
field sensor has to be arranged in different positions. The program keeps
track of those positions in the following window:

®@ o
®

- A Green circle indicates that the calibration has been completed.
- An Orange circle indicates calibration in course.
- A Yellow circle shows where the next calibration will take place.

The Status window shows each operation performed by the program
during the calibration phase.

Frequency Sent

Press the Exit button to leave Radiated mode (the button is deactivated
during the calibration phase).

Exit

Radiated [ 313 |
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When constant field calibration is complete, you may choose to run the
amplifier saturation test.

PMMImmunitySuite

9

t

Would vou like to do the amplifer saturation test?

=1 | Mo

Select YES to run the saturation test within the frequency range.

Amplifer saturation Test

Test @ 81.608 MHz

s

The test verifies the difference specified in EMC regulations between the
power calculated during the calibration phase with the limit 1.8 times that of
the test (Pc) and the power to be applied during the testing phase (Pt). If
the outcome is positive, the amplifier is not saturated and the system is
suitable for the immunity test.

Otherwise, the following message will be displayed:

armplifer nok suitable For testing.
See A TemptSaturakion Test.bxt For detail,

In both cases, a .txt file is generated at the end of the saturation test; the
file is located in the folder PMM Immunity Test/Temp and can be
viewed from the Editor feature (see the Editor section for further
information).

= | 9 0| B 7 U S & | |CouierNew w85 || = | 0¥
table 80 30 : Saturation test - 1271172005 - 10.00.35
Freg. MH= Pz = o = Dif.
g0._0a -31.31 =2 —-36.41 = 5.10
s0._20 -21_47 - -36.41 = 434
2l.el -231.31 = -2E. 64 = £.33
82 _4% -31.23 = —-36.48 = EZEZE
83_Z5 -2l.31 - —-36.6d = 5323
g84_08 -31.14 - —-36_.48 = 5.34
84 9% gl s i = -36. 24 = 4.33
2£.727 =31.23 > —36.42 = E.19
86_63 -31.393 =2 -36.33 = 4.94
27._43 -2l.33 - —-36._48 = E.02
a2.37 -31.47 = -36.49 = L.02
89_EL -31.31 = —-36.33 = E.0E
2000 -3l_23 - —-36.33 = E.1l0
LM I 155

Radiated
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3.7.2 Manual table
creation

"' PMM Immunity Suite - Radiated

You may also fill in the entire table manually.

{ IEC 61000-4-3 )

More

Frequency Level
50.0000
50.8000
51.6080
82,4241
53.2483
54.0808
84.9216
85.7708
8E.6285
87.4348
55.3638
89.2535
90.0000

CEX
() Edit table () Make automatic table
Modify

l Remove J | |

l Fill Table ] [ Clear Table ]

Diisk,

[ Load Browse. l

. T

Table infarmation

Table Name None7|
Start 80.0000 MHz |
Stop | 90.0000 MiKz|
Step L 100
Level 100 Vim|

Setups T Components T Settings

Measure T Break points T Charts
Frequency Level =
Start | _sh_uﬁﬁl MHz Limit 10 | Vim Dwelltime |:12Q9| ms
Stop | ﬂﬁﬁm_ MHz Telarance 1.0] Vim Measures Power/field
Step 1.D—| % W indulation @ dBm O Vim
[ 900.000] Mz Type  [IntAM 1KHz ~ Miliscan
Step percent Depth [ 80| % [] Enabled Exit

Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Select the desired cell, type in the value, and confirm by pressing ENTER.

Maone

Frequency Level
20,0000
80,8000
21,6080
g24241
932483
54.0308
24916
85,7708
966285
g7.4948
98,3698
33,2535
30,0000

[ 315 ]

Radiated
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The amount entered can be deleted by clicking Remove.

b cudify
o
[ Fill Table |[ s Tl ]

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

Frequency Level Frequency Level
B0.0000]v -32.1 a0:0000{v” -32.1
a0.e000|e - A0.8000| = 322
816080 A1.6080|= -32.3
B2 4241 |e e a24241|= -32.4
fa2483 e 32483 | = -32.4
g4.0008|e 240803 | = -325
849216l 24 9216|= 326
BR7F0S|e 25 7708 | = 327
B EZED|e 26 6255 | = -32.8
g7 4948l - a7 4548 | = -32.8
OB 3E98 e 28,3698 | = -32.49
832535 89 2535( @ -33.0
soooogly <331 ao.ooonfy -331

The Clear Table command deletes all of the values entered. The
command must be confirmed.

Frequency Lewvel
80.0000]v -32.1
80.8000|v -32.2
&1.6080]v -32.2
g2 4241|v -32.3
g3.24a3|v -32.4
&4.0808|v -325
54.9216| » [N
gE7v0de o 2 Are You Sure you
G6625le - «-1'/ warit fo Clear TABLE 2
o7 4gddle -
oeaEgd|e e
e I ) 4 | annulla
qoo000je -

The Table information pane displays the main measurement settings.
Table information
Table Name  [None
Start 80,0000 MHz|
Stop | 900000 MHz,
Step [ 1.00 ¢
Level | 10.0 \J’fm

all
i

Radiated
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Once all values have been entered, click Save, then type in the name of

the table and click Save again
Disk,

I Load Browse l

)

Norme file; ltable_80_90 | saba |
Salva come! | Table Files [* Fac) | Annulla

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file:

Save FILE TABLE as

' Z:AProgrammitPMM Immunity Suite|Calibrationsitable_80_90.FAC esiste gia,
. Sostituitlo?

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm the

command. _
ERASE FILE TABLE 2
Cercain: J._’,\ Calibrations :J - I‘j‘ B~
) =] table_50_90.FaC
Recent
(2
[resktop
Documenti
Risorse del
computer
- Nere fil: [tatie_an_g0 T
]
Risorse dirste  Tipo file: |Table Files [* Fac] g Annulla

I Apriin sola lettura

table_BO_90.FAC X

9 Are You Sure wau
4/ wark to ERASE IT
FROM Disk 7

a4 I annulla

Radiated 3-17
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3.7.3 Modifying an
existing table

pi}

O

" PMM Immunity Suite - Radiated ( IEC 61DD0-4-3)

(=]

table 8090 Setup table Measune

Frequency Level
20.0000|v" 372 (&) Edittable: {0 Make automatic table
B0BO00)v 373
BlEoEDly 372 Macity
82.4241|v 372
sy ar2 | Pemoe || |
84.0808[v 372
a8 921 | v a7z [ Fill Table. l [ Clear Table l
garro8ly  -arz
BE.5285|v 372 Drisk
87.4348|v 373
88,2698 R [ Load Browse ]
e -
an.0000|v -3?2 [ Save ] [ Erase ]

Table information

Table Name able 80 90 |
Start 80.0000 MHz |
Stop [ 90.0000 MHz|
Step 1.00 %
Level [ 10.0vim|
Setups T Caomponents T Settings 'i Comment
Measure T Break points: T Charts

Frequency Lewel _

Start 0.000) MHz  Limit 10 v| vm Dwelltime | 1000 ms

Stop Q_ﬂ_aﬁl MHz Tolerano: 1.0] Vim Measures Power/ield

Step 1i]! Yo Maodulation @ dBm O Vim

900.000] MHz Type  [IntAM 1KHz ~| i

Step percent Depth | 80| % [ Enabled Selup ] Exit

An existing table can be adapted to the instrumentation used.
Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Radiated
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Call up a previously created table by clicking Load_Browse, then
selecting the table in the Table File Browsing & Opening window and
clicking Open.

Diisk

I Load Browse l

)

Table File Browsing & Opening

Cerca in: |;} Calibratiots | e & B

__J table 60_90,FAC
Recent

Deskiop

)

Diocumerti

Rizorse del
campuker

‘3 Norme fl: Itable_80_30 A & ]
Flisoree ditete  Tipo file: |Table Files [* Fac) x| Annulla

I Apriin zola lettisra

Select the desired cell, click Remove, type in the new value, and confirm
by pressing ENTER.

table 80_90

Frequency Level
2300000
208000 373
81:6080(%" -aAr.2
gz.d4241 (v G P
032483 (v G P
a24.0808(v" AAF2
34.9216(%" 372 _
gh.7708[v" O P f cnclify
B6.E285(v" -aAr.2 T
T L I [ Remove ] i |
08,3698 v G P ) I
09 2535w a72 I Fill Table ] | Clear Table |
90,0000 372

Radiated
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To delete all data, select Clear Table and confirm

b Are You Sure you
J/ want ta Clear TABLE 7

(] 4 | annulla

If several points need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

lable 8090 table: 8080
Frequency Lewel Frequency Lewvel.
80.0000] v T2 20.0000{¥ T2
80.8000]v 373 BO.B000|v 373
21.6080|v AT2 B1.6080|v 372
g2 4247 | g2 4241 (e av2
332483 = 032483 e SE )
a4 0503 e 94.0808 = av2
49216 e 94.9216(= av2
B5. 7705 m 2h.770e e 373
B6.6285|» o255 = 373
B7.4948|v 373 B7.4948{v" 373
58,3638V 373 58,3698 {v" 373
89.2535|v T2 89.2535(y 372
90.0000] v T2 90.0000(v 372

The Table information pane displays the main measurement settings.

Table nformation

Table Name  [table_80 90

Stait 80.0000 MHz|
Stap | 90.0000 MHz|
Step 1.00 % |
Level ' 10.0 'U’..:'.mf
[Comment
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When all changes have been made, click Save, then type in the name of
the table and click Save again.

Digk

l Load Browse l

[ se || &= |

Norme file; ltable_80_90 x| sava |
Salva come; | Tahle Files [* Fac) | Annulla

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Save FILE TABLE as

"j :AProgrammitPRM Irnmuniby Suite|Calibrationsitable 50 90.FAC esiste gia.
. Sostituirlo?

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open.

ERASE FILE TABLE

SR

Risorse del
compuater

Nome il [table_s0_50 R
Risorse direte  Tipa file: |Table Files [*.Fac) _vJ Annulla

I &priin sola lethura

Confirm as requested.

<> Are You Sure you
-q/ wank to Clear TABLE ¢

(] 4 | aAnnulla

Radiated [ 321 |



A narda

Safety Test Solutions®

3.8 Radiated immunity Once the setup table is ready, the radiated immunity test can be run. Go
test to Measure.

" PMM Immunity Suite - Radiated { IEC 61000-4-3 )

Setup table Measure
S | Generatar
FMIM Frequency
IMRUEITY
SUITE £0.000
N— ) Level
: @ —
PowerMeter | 0 __ __ | RF
RTln R gs r -
DUAL B30 ' |
Generator | i M
0 : prvEpe | || Mo
- | ; Farward
i ‘ ® ea—
Armplifer = I I B
4 SYETEE
] B0 B |l | e
=l RF Dir. Coupler b | | —
; f Field
. [ L JR—
| i
W T s T s i e |
[ Measure |
Setups T Companents T Settings !1
Measure T Break paints T Charts Start Test ! Pause |
Frequency Lewel —
Start [ Limit [10 » Vm Dwelltime | 1000] ms
Stop I 90.000| MHz Toles [ 1.0 Measures Power/figld
Step | 1.00] % M odulation © dBm O Mim e
= " T TR 5 Status
RFOFF | | 10.000] MH: Type [MEUEITE ~|  Mulisean
Step percent Depth 80| % 1 Enabled [ setup [ Exit

Click Start Test.

If no setup table has been selected, the following message will appear:
PMMImmunitySuite

Mo Calibration Table selected, please select it before to continue.

Click OK, then select the table and confirm with Open.

Table File Browsing & Opening @
Cerca in; | |9 Calibrations vr‘ ) (F £® v

= I =

Recent

Desktop

able i
sble_10v_mod Fet

Documenti

L
Risorse del =
computer Mome file: | table_10v | [ Apii ]

.. Tipa file | Table Files [Fet) | [_pmaa |

Risorse di rets [ &pri in sola lettura
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Otherwise the message that appears is as follows:

PMMImmunitySuite

Selected Calibration Table is "table. 104", would wou like to change it?

Cs I w ]

Choose Yes to view the Table File Browsing & Opening window and
select a different table. Choose No to use the file shown and open the
following data entry window (the date and time are entered
automatically).

Immunity Suite - Info & Log

Test Report
Date 02112200 Tons [12.30.18]
Title | |D Company |
EUT. | | siN| |
Ambient
Temperature | | Humidity | |% Atm.pressure | [mh
Table table_10v Operator |
Note:

Enter the name of the immunity test.

Title || [

Click and enter the test name, then Save.

Marne file: jHadiated_test_SD_SD lJ Salva |
Salva come: 1Te:-ct Files [ tst) _-r_J Anrulla

If an existing test is selected, a confirmation message will appear.

Save File Report as

'E :\PraogrammilPMM Immunity: Suite|ReportsiRadisted test: 5090,k esiste gia,
L4

Sostituirlo?

Fill in the fields Company, E.U.T., S/IN, Temperature, Humidity, Atm.
Pressure, Operator and Note.

Radiated [ 323 |
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The data entry window is now complete:

Immunity Suite - Info & Log
Test Repart
Date  [16/112009 |

|[.] Company [Narda STS

| SN [FRO015A231 |

Title |Radiated_test 80_00td

ELLT. INome del digpositiva softo test
Ambient
Temperature | 23|

Table itable_s 0_490 Operator |Ro

o |

MNote:

Done

Confirm with Done to start the immunity test.

If an existing test is selected, a confirmation message will appear:
PMMImmunitySuite X |

N

Sould you like ko cancel the old file?
IF WO the rew data will be append
to the end of existing File:

[ =

J

Mo ]

Choose Yes to overwrite the data with the test in course.
Choose No to append the new data.

CEX

{ JEC 61000-4-3 )

Setyp table Measure
50.00 Generator
Frequency
40,00
85.770820 MHz
30.00 Lewel
o ¢ .37.2dBm
1101600 [ RF
= oo
m Measures
< Bz
000 |~ Fonward
& 4.5 dEBm
20.00
Reverse
3000 ® -10.4 dBm
4000
50,00
800 2.0 820 B30 40 5.0 ae.0 B7O0 2a0 g3.0 0.0 [ Measure ]
MHz
Setups T Cormponents T Settings }
Measure 1 Break paints i Charts Abort Test ‘ [ Pause
[1
—
it I dBim “ Shatus
e A Frequency Sent
(o) | W e
: [Semp | Exit
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During the test, the Generator window shows the level extrapolated from
the setup table and used by the generator to obtain a constant magnetic
field in the selected frequency range. The color of the dot corresponds to

the color of the line on the graph.
ngerator

Frequency

82.424080 MHz

Level

® 37.2dBm

The Measures pane includes:

- Forward: shows the direct power measured by the power sensor.

- Reverse: shows the reflected power measured by the power sensor.

- Field: shows the magnetic field generated within the cell.

The color of the dot corresponds to the color of the line on the graph.
Meazures

Forward

& 4.0 dBm
Reverse

¢ -10.4 dBm
Field

o 3.439 Vim

During the immunity test, the frequency range, generator level and
magnetic field will be shown in graph form.

50.00

40,00

30,00

20,00

1000

= pomo
000
2000
30.00
40,00
50,00
a0.0 2.0 gz 230 4.0 a5.0 880 arn a0 g3.0 a0
MHz

At any time, the test can be terminated by clicking the Abort Test button
and confirming:

ABORT TEST

?‘_j Sure vou wank
g,

ko FINISH?

oK | annulla I
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The Pause button can also be used at any time to stop the test
momentarily (the generator is set to RF OFF). In this state, an earlier
situation can be recreated or a later one can be simulated; click the RF
button (the generator is set to RF ON), adjust the frequency and level, and
click Measure to display the values.

Generator
Frequency
85.770820 MHZ%
Lewvel
e .37.2dBm |5
[ RF ]
Measures

Measure

Each time the Pause button is clicked, the following window will

appear:
B0 Immunity Suite - Info & Log
Test Log i
40.00 S
Tifme [ 15.56.18 |
30,00 Frequency | 81.608000 MHz |
20,00 i -37.2 dBm|
Field | = |
10,00 Forward 5 'I_I:IEI_r'nI
= Reverse -10.
£ gm |___1lA0Bm)
d—:’, Mote:
10.00
-20.00
-30.00
40.00
5000 [
o oo mn mo 6
w——

Radiated
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Pressing Save assigns a marker to the current position for future
reference. At the end of the test, the saved information can be
viewed simply by hovering the cursor over the marker.

BO.00 B0.00
¢ 5, |
4000 4000 IMharker n®1 i_
A [Freq. = 81.608000 MHz i
3000 [Level = -37.2 dBm T
30.00 [Monitor = - =
20.00 ilrull =5.1dBm ‘_
2000
10,00
= 100
& oo
Anoa 0o
2000
A000

The button will now read Continue to resume the test.

H0.00 0 @ €)

40.00

30.00

20.00

10.00

n.oo

dBm

-10.00

-20.00

-30.00

-40.00

-H0.00
800 a1.0 az0 aa0 B0 a5.0 ge6.0 87.0 Ba.0 230 0.0

The status window shows each operation performed by the software
during the test.

Frequency Sent

The end of the immunity test will be announced with the message:
IEC 61000-4-3 [X]

-
- | ,;' Test Finished

Radiated
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When the test is over, the graph can be saved in .bmp format by right-
clicking anywhere in the graph and selecting Save bmp.

50.00 0 @ @

40.00

30.00

20.00

10.00

0.00

dBm

-10.00

-20.00

-30.00

-40.00

-50.00
B0 g1.0 gz.0 830 B4.0 aa.0 860 870 BED 83.0 qp.0

In the next window, assign a name to the graph and press Save.

Maome: file: | aph_tezt BO-50 V| [ Salva ]

Salva come: | bitrap T, bmip] vl[ Apnulla ]
 Etuabblon b |

The saved graph can be inserted into a text file using the Editor feature
(see the Editor section for details).

Press the Exit button to leave the immunity test.

Exit

Radiated
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4 — PMM Immunity Test
Conducted

4.1 Introduction to The purpose of the test is to check the immunity of equipment, individual
conducted mode devices or systems to disturbances caused by radiofrequency
electromagnetic fields to connection cables, power cords, signal lines and

File: e ground wires. The standard for equipment, setup and procedure is EN

m Radiated | 61000-4-6
Exit At o

Loading Conducted Module
| |
L=

- Conducted

(o O o Oma o i
PN
IMIAUINTY
SUITE
Generatal
| 9
Amplifer
[ pumwavon|f5
%ﬁ iaB
AE CONor Clamp EU
Device
Erd101
Setups T Components T Settings ]
Generators T Fower Meters T iDevicesi ﬂ/ Frobes T Others
Sele_cted‘ Marrig ‘T}lpe M[igé?n\id M_F;Blfn\]f?l

EMCLAMF Clamp, 00 10
M323 | CON 40 10
Y EMIOT  Clamp 40 10

Exit

Fig. 4-1 Main window - Conducted

This window contains:
Menu

Diagram window
Function tabs
Setup table
Measure;

abrwN -~

Document PMMISEN-71003-2.16 — © NARDA 2017
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4.2 EN 61000-4-6 Once Conducted mode is launched, the type of setup needs to be chosen.
Setups The program offers:
- CDN/Clamp

- Clamp + Current probe

s 1 Components 1 Settings

® IEC 6100046

(%) CON/Clamp

() Clamp + Current probe

Conducted
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4.3 Equipment selection
(Components)

In this phase you will select the equipment to be used during calibration or
testing. The program divides equipment by type; for your convenience,
drivers from the PMM family can be used. To enable the desired
module, double click the corresponding line (a ¥ will appear next to the
instrument selected).

- Generators: Lists the available field generators
’ Generators! Power Metars % Devices T Frohes
Selected Mame Bruz type aBd-LéSL EELT‘ St[‘?;ltl_:';q' Stﬁ;r:]q' M[IQBIEI::]EI M?;Elfn\]’e'
DUMMY GEN | GFIE o0 0.01 20000 100 20
FMM 2000 RS2z | x| 3 0.01 1000 a0 10
PMM 3030R5 | F5232 | % | 1 0009 3000 407 10
V. PMM30300SE | USE WooW 0009 2000 07 10
© | PMM 3010USE | USE WooW 0.o0s 1000 407 10
PMM 2010RS | BS232 | % | 1 0.003 1000 07 10
- Power Meter: Lists the available power meters
Genetators Power Meters! Devices T Probes
Selected M armne Buztype aEdLul:ISr, E;gﬂn' S-t[‘?\;ltl_:[ze]q' S-t[nb:,ljlj[:]-q' M[IQBIT‘_:]El M?;Eﬁ?e'
DUMMY PM USB X R 0.01 E000 40 ER
¥ PMMEE30  USB x| % 0.003 3000 40 a0
PMMEEDD | RS495 | 1 1 0.0 1000 -40 27

- Device: Includes all Clamp and CDN models.

Generatars T Fower Metars T
Selected [ Mame | Tupe M[QE:ﬁ:iEd Mfsalfn"‘]’e'
| EMCLAMEF| Clamp -100 10
|M3-25  CDM -40] 10
L Er101 Clamp -4l 10

- Current Probes: Shows current probes with the names of their

calibration files.

| Generators T Fower Meters T Devices T EthesE
Selected Mame Cal .File
L 33 1_41 331_411 cpf
- Others: Shows the ampilifier,
Generators Power Meters Devices T Prahes T Othersi
Enviranment impedance
(%) 150 ohm ) B0 ahm
Amplifer )
Aftenuator
Namie [PMM 6000N | || T elae
Conducted
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Additional devices can be added to each of these tables by right-clicking
and selecting Add new.

Generators 1 Power Metars T Cevices T Frohes
B Cararn. | Start freq. | Stop freq. | Mitlevel | Max level
et Name |Bustype| oo 00 e | e | B | o)
DUMMY GEN GPIE 3 =~ =7 20000 -100 20
PMM 3000 Rszaz | & U 1000 £0 10
PMM3030RS  R5232 | ¢ : || 3000 107 10
v PMM3030USB USB. | ¥ | | 3000 107 10
PMM 30100SE | USE b || 1000 107 10
PRkt 201 0RS R5232 i CheckDevice 1000 107 10

Immunity Suite - add Generator

Instruments name i i

Instr. driver name [ |

Bustype ' v |  Bus Address |_D

Com Port num. | o
Freguency range

From o | | MHz
Level [imits
From [ 1 to [ | aBm

Save LCloze

Devices can also be checked, modified or removed by right-clicking from
the corresponding line:

Generators T Fowar Meters T Davices i
Selected MHame Busz type aBdLés;. E;gﬁn' St[‘?;ltl_:rze]q. St[?\!,lnl_:[:iq'

DUMMY GEN | GPIB ® i 0.01 20000
Flbd 3000 RS232 | X 3 0.01 1000
PMM 3030RS  ASZ232 | % 1 0.009 3000

W ep Wl 0.009 3000
PMM 3010056 | Add new ¢ ooos 1000
Phib 3010RS Madify 0.009 1000

— ——————
Check Device

For connecting and setting the COM port of fiber optic
equipment, see the user manual supplied with the device.

Conducted



7 N

narda

Safety Test Solutions®

- Modify: changes the properties of the device

Immunity Suite - add Generator

Instrumems name [PMM 3030058 |
Instr. diiver name [PMMz0200L [
Bus type !USEI v

Freguency range

From | 0008 to | 3000| MHz
Lewel limits

From | 10_? to | 1D| dBm

- Remove: removes the device and its driver from the list.

- Check Device: makes sure the driver is working and the device is
properly connected. This option is only available for the device selected ().

If the device is connected and the driver has been correctly installed, the
following message will appear:

PMM 3030058

8

Driver best.....Driver works correctly
Device kest, ... Device Ok

This message will appear if the device has not been connected
properl

to the work setup
PMM EP601

X

Driver test, ... Driver:works correctly
[Device test, ..., Error during Device test

If the driver of the device has not been installed properly, the screen will
show:

PMM3030U

PMM 3030058

@

Instruments comunication error is occurred,
Test will be aborted

@ DDE Driver not Found

We recommend performing a device check before starting the
calibration phase or immunity test. In any case, before calibration or
testing, the program runs an automatic check and reports any errors as
described above.

Conducted



4.4 Diagram window

7 N

narda

Safety Test Solutions

@

The diagram window shows the setup to be followed on the basis of
the equipment selected.

Generator

Amplier
PMM 60001 ]

Setup table

() Edit tahle

Measure

() Maks attomatic table

%6 aB
AE CDHN or Clamp EU
N
Device
EM101
Setups T iComponents T Settings
Generators T Power Meters Devices Prabes T Others
Bus [Comm | Startfreq. | Stop fieq. | Min level [ Max level
Bpkecled Mame  |Busbpe| oy | pot | MHZ | iMHal | Bw) | [dBm)
DUMMYGEN GPIE_ | % | 0 .01 20000 00 il
PMM 3000 R5232 = 3 {allui] 1000 a0 10
PMM 3030RS RS2 K 1 | 0009 2000 07 10
v PMM 3030LISB | UISB = S 0003 3000 -107 10
PMM30I0USE USE X K | 0009 1000 107 10 -
PMM 3010AS  AS232 | % | 1 g 1000 07 10 l Exit

The selected devices (V) are shown at the bottom of the pane.

In addition to using the Components tab, you can move from one type of
equipment to another by clicking the label with the device's name
| PMM 3030USE

| in the diagram window

Conducted
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4.5 Settings

After performing the setup shown in the diagram window, the calibration
test parameters need to be set using the Measure tab:

Measure T Break points T Charts
Freguency Lewel e —
Stat | 0.150/MHz  Limit 10 x| V Dwelltime | 100] ms
Stop [ 200000 mHz = Tolerance 250, V
Step |JI % Modulation
@l i ke Type &—Vl Multizcan
Step percent 0] ¥ - Setup

The Multiscan feature allows you to modify measurement parameters
within a given frequency range.

P MM MULTISCAN Setup
M::gican E‘IJ‘I:::“S Step | Dwell|  Modulation | Depth  Table Name Level
MHz MHz z= mS5ec 4 ¥/m
I e e I el
| o S|l Sl
[ =) -
[ =[] Sl
N o B el
| S|l Sl
C | C ) ) Al e -
C | =] =l

Conducted
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With the Break Points tab, you can set the frequencies at which
measurement will be temporarily suspended to allow a change in setup.

M Ree | Break points! I Charts
_F_"ef_--Mﬁi Comment
5 Carbia Amplificatore

St_op 2_ 32
[ stop 3
[ stop 4 ||
=

|
sop1 |[[ 2 |
|
|
|
|

i Cambia A]nﬁiifiﬁatore
|
|
|

Each time the stop frequency is reached, a message will display the
scheduled action.

Break point 2 @

LS
“Ef) Cambia Amplificatore

The break points are shown as vertical stripes in the graph.
Click OK to continue measuring.

The Charts tab allows visual modifications to suit your preferences.
For each element, click on the color shown, and change it using the
Windows color box if desired.

In this tab, you can also move the reference level along the y-axis (+ and -
buttons), or change the power level and range (in dBm), the voltage (in V)
and the current (in mA).

Break poirts

Colot [ Trace
C [#] Generator [l [ Forward PM
LirEor

Color — ] Maniito I [JReversePM

Measure T Break points T
Graphbype Chiart Reference position ReterenceRangs dbm
Linear BackColor [ Value| 0/dBin Range [100 + |aB
4 I |
Grid Color (| [:] v

Conducted
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4.6 Settings management

Open setting

Save setting
Save setting as...

Display

Exit

ChrlH-O

Chrl4+5
ChrH-4

Chrl4-s

For each new session, the default file CondDefault.tsc is loaded. To avoid
having to re-enter preferred settings, they can be saved in a single .tsc file:

| The command File -> Save setting overwrites the file in use. If no file was
| called up when the program was opened, the default file will be

overwritten:

| The following message will appear

PMMImmunitySuite

-
\%) The settings file will be changed, are you sure?

Si | Mo

Choose YES to overwrite the file in use. Choose NO to cancel the
operation and return to the main window.

File -> Save setting as... Enter the file name assigned to the work
session and press Save.

Nome file: FE=ting 10y v [ sava |

Salva come: ! Counducted Immunity Settingz Files [*. TSC) 2| [ Annulla J

The file can be called up at any time with the command File -> Open
setting.

Conducted Immunity Settings File Browsing && Opening

Cercain: |l-'-;)\nfar vl G Sl

-

. [ condpeFani, 750
__J Sefting_10v,T5C
Haded |t setting_150_400.T5C

Desktop

Diocumenti
53
Rigorze del ! —
computer Marne fils; |LS atting_104 bl [ Apri ]

% Tipo file: |Cnnducted|mmunity Seftings Files [ T5C) Vl [ Aninulla l

Risarse di rete [ &pti it sola lettura

File -> Display -> Default colors is used to restore the original display.

Conducted
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4.7 System calibration You can now calculate the levels assigned to the generator in order to
have a constant voltage within the chosen frequency range.

Arrange the setup as shown in the graph:

' PMM Imunity Suite - Conducted

Setup table

*‘ ‘ () Edit table

PAM
IMMUINTY

SUITE E't'éi':cj i

—

__

| Table Autoratic DEVICE=F-120

Gerierator ———
[stattes ] [ Pae
Generatar
Amplifer [ MHz i
}w L
[— 1} ® dBm
. Power Meter Power Meter
" PMM EE30 S v

Coupli
u pling
Device

Setups T Companents T Settings
@ |EC 61000-4-6
&) COM/Clamp
Status
() Clarnp + Current probe
[ Exit
4.7.1 Setup table There are different ways to create the table:

- Automatically (select Make automatic table)

- By adapting the automatically created table to the instrumentation
used (select Edit table)

- By completing the entire table manually (select Edit table)

Conducted
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4.7.1.1 Automatic table
creation

To create a table automatically:

- Select Make automatic table

" Edit tabls ) Make automatic table

G

=] assign a name to the table and press Save.

i@

- Select

Name il ITable 10 v | sakva

Salva come; :Tal:-IeFlle_s[“F-:t] \:| [ Annulla J

If an existing table is selected, the following message will appear:

Save FILE TABLE as

' C:APrograrmmitPMM Irmrmunity: SuitelCalibrationsitable_10w FCT esiste gia.
[ SostitUirlo?

L s J[ _m |

Choose YES to overwrite the table.
Choose NO to cancel the operation and return to the main window.

- A comment can be added, if desired.
[T able Automatic DEVICE=F-120

- Press Start test, then Abort test if you wish to terminate the process at
any time.

[ Start Test ‘ N [ Ahort Test l

A Pause button is also available, and becomes Continue to resume the
process.

[ Fauze l N [ Continue |

Conducted
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The Generator window shows the level (in dBm) entered by the
generator, at a given frequency (in MHz), to generate the voltage

required.
Generator
. 34461MHz |
® 2.3 dBm l

The color of the dot corresponds to the color of the line on the graph.

The voltage applied will be shown in the Power Meter window.
Fower Meter Frower Meter

®| 1004V | e STN—

Values outside the selected tolerance will be shown in red; the
generator will adjust the level to bring the voltage back into range. The
color of the dot corresponds to the color of the line on the graph.

During the work session, the generator level and voltage within the
frequency range selected will be shown as a graph.

40,00 14.0
30,00 13,0
A = o v
2000 " b 120
8
10.00 I 4 \-\JJ‘V\.‘ 1.0
L4} M =
000 h‘" A £ === 10
b
E 400 90
= 10,00 30
-20.00 a0
-30.00 7.0
-40,00 B0
50,00 5.0
£0.00 40
Efiks 201 401 B0 a0 1007 1207 140.0 1600 180.0 200.0
MHz

Wait for the calibration to finish.

L]
“:\!J) Calibration Finished

The Status window shows each operation performed by the program
during the calibration phase.

Frequency Sent

Press the Exit button to leave Conducted mode (the button is deactivated
during the calibration phase).

Exit l

Conducted
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4.7.1.2 Manual table You may also fill in the entire table manually.
creation

fi ]

" PMM Imunity Suite - Conducted

Mone Measure

Freq.[MHZ] Level [dBm] - =
01500)s - (=) Edit table
01515|s -
01530)s - odify

g};g? _____ R 2208m
31:;; — [ FilTable | | Cloar Table ]
01608
01624
TR
01657
01674
01630
01707
01724
01741
01759
01776
01738
REE
01530
01843

Setup table

..... Dizk

..... I Load Erowse ‘

[ Save | [ Eraze |

..... Table information

..... Table Name None—|
----- Start [ .1500 MHz]
= Stop [ 200.0000 MHz|
----- Step L 1004

Level [ 10.0 V|

Setups T Companents T Settings

@ |IEC 61000-4-6

() CON/Clamp

(% Clamp + Current probe

[ Exit

Check the information in Setups, Components and Settings.
Go to Setup table -> Edit table.

Select the desired cell, type in the value, and confirm by pressing ENTER.

Freq.[MHZ] Level [dBm]
01500

01515 I
01530
01545
01561
0.15%7
01592
01608
01624
01641
0.1E57

01674
n4ean

Conducted
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The amount entered can be deleted by clicking Remove.

W adify

[ Fill T able

I [ Clear Table |

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

Freq[MHZ) | Level [dBm) Fiea[MHZ) | Level [dBm]
0isa)y 102 oisoa)y 10z
015/5e - 01575 103
016548 - 01654[s 104
017scle - 01736[s 105
018238 - 01szile 0B
0191dj@ - 01914je 07
02010/8 - 020i0je 07
0Z1)s ozljs 108
02216)s - 022E[e 109
02357|e - [ LS
024438 02443 111
02566l — 0ZGe6(e 112
e nzesdls 113
T L 0zezale 114
e 0za7lje 115
03ee  — 0z1ae 116
03zrde Oz7de 16
0343e  — o3zEe 17
03Ee  — oaei0je 118
0373(e - oz7a0js 119
ozaje nzae0)e 120
om0l 21 L o4mooly 121

The Clear Table command
command must be confirmed.

deletes all of the values entered. The

FiegMHZ] Level [dBri]
01800y 0.2
01676y 10z T
D1E54|V 0.2
0736y q0.2
0183y 0z
01914y 0z
gzmaly 0z
32121;; . 102 ? Are You Sure you
; " :
0.23z7) e Wanit ko Clear TABLE
02443
0.2565| @
0.2694| = ITI annulla
02820

The Table information pane displays the main measurement settings:

Table information

Table Name  [None |
| .1500 MHz|

Start
Stop
Step

Level

Conducted
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1.00 %)
10.0 V|



7 N

narda

Safety Test Solutions®

Once all values have been entered, click Save, then type in the name of
the table and click Save again.

Digk
I Load Browse l
[ Save J [ Eraze J
Name file; [T abile 10 v | salva |
Salva come; | Table Files [’I‘_F.:t] w | [ Annulla J

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Save FILE TABLE as

'E Z:i\PragrammilPMM Immunity: SuitelCalibrationsitable_104v.FCT esiste gid.
. Sostituirlo?

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm the
command.

ERASE FILE TABLE ?)X]

Cercain; |L-:}Ca|iblations ¥ & ? = G-

Recent

=
|

[ezktop

=

- o

\ 0
1 £ 3
T = -

]

=

Rizorze del
computer M arne file: | table 10w

Apri ]

Annulla ]

-~

—_—

Tipo file: | Table Files [*Fct]
[ Aspri in sola lethura

&

Risorse direte

table_10v,FCT X

£ Are You Sure you
-\;f} wank ko ERASE IT
FROM Disk 7

[ Ok ] [ Annulla

Conducted



4.7.1.3 Modifying an
existing table

' pMM Imunity Suite - Conducted

table 10y
Freq.[MHZ] Level [dBm] -

01500y -2.8

01515y -28

015300V -28

01545y -28

01561 (v -28

01577 -28

01592y -2.8

01608y -28

01624|v -2.8

01641 |V -28

01657 -28

01674V -28

01690y -28

01707 (v -28

01724y -28

017 | -28

01759y -28

01776 -2.8

0.1794|v -28

aigiz)y -28

0.1g30)y -28

CRELE| Y] Ad

Setups T Companents T Settings
Measure T Break points T Charts

Frequercy Level : =
Start 0.150/MHz ~ Limit [10 v Dwelltime. | 100| ms
Stop 000! Tolerance Z.SI]-_
Step Madulation
Type  |IntAM 1KHz v Multiszar
Step percent Depth Setup

A narda

Safety Test Solutions®

Setup table Measure

[ Furate | |

Clear Table l

I Load Browse ‘

[ Save | [ Erase |

Table information

Tahle Name  [table_10v |

Start [ .1500 MHz]
Stop m:
Step [ 1004
Level

[T able Automatic DEVICE=F-120

Exit

An existing table can be adapted to the instrumentation used.

Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Conducted
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Call up a previously created table by clicking Load_Browse, then
selecting the table and clicking Open.

Dizk

I Load Browse l

)

Table File Browsing & Opening

-

Cerca in; |lr-;}EaIibrali0ns Vi S R

Deskiop

Documenti
e
Risorse del : =
computer Monme file: [table_10v ]

[ ]
i;j Tipo file; |T_abIeFiIes[".Fcl] "I[ Annulla ]

: [ &pti ik zola lettura

Rizorze di rete

Select the desired cell, click Remove, type in the new value, and
confirm by pressing ENTER.

table_ 10y
Freq.[MHZ) Lewvel [dBm]

o150y 28
DA5I6)Y 28 d
01530y 28
01546 28
DisElY 28
01577y 28
01592y 28 b odify
R T P -
01624 28 [ Remave l FOEHRn |
DiEdl|Y 28 7
L)y 28 [ Fill T able ] | Clear Table ]
D1E7dly 28
mACcanl.” T a

Conducted 4-17
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To delete all data, select Clear Table and confirm.

2 Are You Sure you
m‘/ wanit to Clear TAELE 7

Ok | Annulla |

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

table 150400 table_150_400

FieaMHZ) | Level[dBm] || Fieq(MHZ] | Level (dBm| ||
gi500v 0z B gi500v 0z N
T 057y 02
0IEs4y 102 0IEsAy 02
0173V 0z 0173V A0z
01823 e 0iGz3|e 04
01914s 0ia1dls 07
0.2010] e oeoiole 04
02111|e ootl|e 1z
0Z21Ely 114 02216y 14
nzalvy 14 ooz d14
D243y 114 o243y 14
0256EV 114 0o5EEY 114
T 0oEsdy 14
neezsly 114 nzezaly  d14
ozarlvy 114 noar|y 14
gattaly 14 oa1Ely d14
03z 21 nazaly 21
o343y A1 D343y 21
oIy 21 R TR
oIy A1 oars|y 21
g3em)y  Az2d g3em)y 21
gaoonfy 21 Bd gaoonjy 121 Ed

The Table information pane displays the main measurement settings.

Table information

Table Name  [None |
Start 1500 Wiz

Stop | 200.0000 MHz|
Step 1.00 %
Level j 10.0 V|

Conducted
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Once all values have been entered, click Save, then type in the name of
the table and click Save again.

Digk
I Load Browse l
[ Save J [ Eraze J
Name file; [T abile 10 v | salva |
Salva come; | Table Files [’I‘_F.:t] w | [ Annulla J

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Save FILE TABLE as

'E Z:i\PragrammilPMM Immunity: SuitelCalibrationsitable_104v.FCT esiste gid.
. Sostituirlo?

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm
the cmmand.

ERASE FILE TABLE ?)X]

Cercain; |L-:}Ca|iblations ¥ & ? = G-

Recent

=
|

[ezktop

=

- o

\ 0
1 £ 3
T = -

]

=

Rizorze del
computer M arne file: | table 10w

Apri ]

Annulla ]

-~

—_—

Tipo file: | Table Files [*Fct]
[ Aspri in sola lethura

&

Risorse direte

table_10v,FCT X

£ Are You Sure you
-\;f} wank ko ERASE IT
FROM Disk 7

[ Ok ] [ Annulla
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4.8 Immunity test WITH If an injection clamp is used, the AE configuration must present
Impedance common-mode impedance (consult EMC regulations for further details).
Requirements
(Setups) If the impedance requirements are satisfied, select CDN/Clamp.

7 PMM Imunity Suite - Conducted

PR
IMMUIITY
SUITE

Generatar

FMM 3030USE 7

[ Amplifer ]

P 600011 ]

%ﬁ dB

AE CDN or Clamp EU

Device

F-120

Setups T Components T Settings

@ IEC 61000-4-6

) Clamp + Current probe.

Conducted
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4.8.1 Starting the test

' PMM Imunity Suite - Conducted

Go to Measure.

EEX

Setup table Measure
fome Generator
Frequency
3000
3977 MHz

20.00 Level

1000 ® -2.8 dBm

000 | -
£ 000
m Messues
- "

20,00 Mt

-30.00

-40.00

000

L
-B0.00
015 201 401 B0 ool 1207 1400 18RO 1800 2000 [ — ]
MHz
I Il N Abort Test l [ Pause
ol
= ! Status
' Bl | For atd PN Sending Level
. = | TX Exit
Click Start Test.

If no setup table has been selected, the following
PMMImmunitySuite

Click OK, then select the table and confirm with Open.

Table File Browsing & Opening @
Ceicain ‘Dtahblal\ons vl D & 2 B
v FCT
__J E able _10v_mod, Fet
Fiecent
Desktop
Documenti
Risorse del
computer Marme: file: ‘lab\e_‘\ Ov V‘ [ Apii ]
5. Tino fe | Table Files [Fot) v [ anrula |
Fisares diete [ &pri iy sola lettura

Conducted
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Otherwise the message that appears is as follows:

PMMImmunitySuite

Selected Calibration Table is "table 100", wiould you like ko chanige it?

= I % ]

Choose Yes to view the Table File Browsing & Opening window and
select a different table. Choose No to use the file shown and open the
following data entry window (the date and time are entered
automatically).

Immunity Suite - Info & Log

Test Report

Date 021272009 | Time  [12.39.18 |

Title | |[:J Company | |
ELLT. | | s | ]
Ambient

Temperatlllel | Humidity | |% Atm. plessule! iml)
Table table_10v Operator |

[Note

Daone

Enter the name of the immunity test.

Title || ]

Click [:] and enter the test name, then Save.

Marme file: E::m::]r_m:te:l i=c i V| | Salva I

Salva came: | Text Files [ tat] > Aol

If an existing test is selected, a confirmation message will appear.

Save File Report as

' C:\ProgranmmitPMM Immunity Suite\Reports Conducted_test_80_90.txt esiste gia.
L3 Sostikbuirlo?

Fill in the fields Company, E.U.T., S/N, Temperature, Humidity, Atm.
Pressure, Operator and Note.

Conducted
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' DMM Imunity Suite - Conducted

The data entry window is now complete:
Immunity Suite - Info & Log

Test Report

Dae 171112009 Time  [15.36.29]

|[.] Company [Narda STS |

| s |[FrROO154231 |

Title | Conducted test_10v.tt

Table [table 10v |

Note:

Confirm with Done to start the immunity test.
If an existing test is selected, a confirmation message will appear:

PMMImmunitySuite

7N

‘wiould you like to cancel the old file?
IF MO the mew data will be append
to the end of existing file.

[ s

J [

Mo ]

Choose Yes to overwrite the data with the test in course.

Choose No to append the new data.

EEX

Setup table Measure
40.00 Generator
- Frequency
30,00
54.2432 MHz
20.00 Lewel
S ® -1.5 dBm
0.00
— | RF
£ qnon
m Messues
20.00 y
30,00
-40.00
-50.00
\
H0.00
018 201 40.1 B0 80.1 1009 1201 140.0 160D 1800 200.0 [ MEsE ]
MHz
i . Abort Test l [ Pause
il
=
Statug
Sending Level
I
= hi = Range[100ma « | Exit

Conducted
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During the test, the Generator window shows the level extrapolated
from the setup table and used by the generator to obtain the required
voltage.

The color of the dot corresponds to the color of the line on the graph

Frequency

6101 MHz

Level

® -2.8 dBm

During the test, the frequency range and generator level will be shown in
graph form.

40,00

3000

20,00

1000

n.oo

000

dBm

-20.00

3000

-40.00

000

000
015 201 401 E0.1 801 1001 1207 140.0 1600 1800 2000

MHz
At any time, the test can be terminated by clicking the Abort Test button
and confirming:
ABORT TEST %]
b d Sure you wank
'n.:/ to FINISH?

(0] 4 annullz |

Conducted
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The Pause button can also be used at any time to stop the test
momentarily (the generator is set to RF OFF).

In this state, an earlier situation can be recreated or a later one can be
simulated; click the RF button (the generator is set to RF ON), adjust the
frequency and level with the arrows, and click Measure to display the

voltage.
L":E:ner_atur .
Frequency
8306 MHz (5]
Level
e -28dBm 5
[ RF |
Measures
[ Measure ]

Each time the Pause button is clicked, the following window will

appear:
4000 Immunity Suite - Info & Log
Test Log
2 Time
2000 Frequency
Lewvel
1000
I Monitor
0.0 Forward
T
I Reverse
= 000
L Mote
=
-2000
-30.00
-40.00
50,00
-R0.00
015 200 401 50,1 VR IS VR A VA R E i [ save || Ciose |
.

MiH=

Conducted
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Pressing Save assigns a marker to the current position for future
reference. At the end of the test, the saved information can be viewed
simply by hovering the cursor over the marker.

1) (2] O [ [ (&1 7
I-L-\Erkernﬂ ]

[Freq. = 138.214%8 MHz

Level = -1.8 dBm

In'y'lunitq:-r = FrE
——Fwitl = - —
——Rev= o —
P
P
The button will now read Continue to resume the test.
40,000 0 6
3000
20,00
1000
0.00 —
5 Anon
-20.00
30,00
-40.00
-B0LE0
000
015 201 401 B a0 1001 1201 1400 TRO0 1800 2000
MHz

The status window shows each operation performed by the software
during the test.
Frequency Sent

The end of the immunity test will be announced with the message:

3

(]
‘:HIJ) Test Finished

Conducted
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When the test is over, the graph can be saved in .bmp format by right-
clicking anywhere in the graph and selecting Save bmp.

40,00 0

30.00

L

20.00

10.00

0.00

-10.00

dBm

-20.00

-30.00

-40.00

50.00

-60.00
015 209 401 BB a0 1001 1207 140.0 1ED.0 1800 2000

MHz

In the next window, assign a name to the graph and press Save.

Mame file: loraph_test G050 V| [ Salva ]

S alva come:; !bitmap [*.bmp) vl [ Annulla ]

The saved graph can be inserted into a text file using the Editor feature
(see the Editor section for details).

Press the Exit button to leave the immunity test..
[ Exit |

Conducted
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4.9 Immunity test If the impedance requirements cannot be met, the current produced by
WITHOUT impedance the induced voltage must be checked using a supplementary probe
requirements (Setups) placed between the injection clamp and the EUT (see EMC regulations

for further details). For this configuration, select Clamp + Current probe.

. PAM Imunity Suite - Conducted
[ e |
IMLIITY
SUITE

Gererator

PN 3030056

Power Meter

Amplifer
|
EU
F-120 331 411
Setups T Companents T Settings

& |IEC 6100046

) COM/Clamp

This procedure provides only significant differences with respect to the
previous test.

Conducted
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4.9.1 Monitoring the Go to Measure.
current

' PMM Imunity Suite - Condl.ﬁted

Setup table T Measzure
40.00 100.0 Generator
525 i i Frequency
SO0 [
1624 MH=z
20.00 ean Level
s 5 ® -2.8 dBm
0.00 E00 | e
E qgm 5003
m | Messues 5
-20.00 a0 Foritor
* 2.03 mA
30,00 00 Farmerd
-40.00 200
000 168 e
0,00 ol J
018 201 401 60,1 g1 1007 1201 1400 1EDO0 1800 2000 [ MESEIE |
MHz

Abort Test l [ Pause

Statuz
Sending Level

[ Exit |

The example below shows the current and the generator level during a test
in which the current limit is exceeded and then brought back into range by
the software. The correct generator levels will be saved and used during
the second sweep.

40.00 1000

30.00 900

2000 800

10.00 700

0.00 .Y £00

— T

E oo / \ 5003
m 7 g
22 T

2000 N 400

30.00 / 300

/’f
40.00 00
—(f!
50,00 T \L/ 100
1
-
.00 o0
015 01 401 B0 801 1001 1201 1400 1e00 18m0 2000

MHz

Conducted



4.9.2 Second Sweep
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When the process has finished, you can save the new table calculated
during the first sweep. If no name is assigned, the program will use the
name of the previous table and add " modified" (e.g. tabc_
10v_modified.fct).

After the file is saved, a prompt will appear to conduct a second sweep
with the new table.

9 e
\_‘./ Would you like to start the second sweep

L5 J[ mo |

The graph below shows the new generator levels applied during the second
sweep.

Setup table Me

4oon 100.0 Retretar
Frequency
0.00 Q0.0
200.0000 MH
0.00 enn Level
10,00 200 ® 1.3 dBm
oo & e
= 7 —
= 1000 \ 50.0 3
m T | Measurss
20.00 AN tonitor
-30.00 300
40,00 200
B000 10.0
E0.00 o0 B =
18 201 401 B0 a0.1 1001 1201 1400 1E0.0 1800 2000 E
MHz
Setups il Components il Settings T o
Measure T Break points T Charts Start Test | rat
Franb hire Chist Riefersnes nnsitiorn Flefitmneat Banne dim ¥
< | >

At the end of the test, the table will appear with the new values marked
by a red dot.
L1

Bhd |V -1
01736V 102
01823 m -10.4
01374 |m 0.7
02070|m 104
02111 | = -11.2
A ade 14 4

Conducted
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5 — PMM Immunity Test

Automotive
5.1 Introduction to The purpose of the test is to check the immunity of equipment, individual
conducted mode devices or systems to disturbances caused by radiofrequency
electromagnetic fields to connection cables, power cords, signal lines and
- PiM Immunity Suite Rel, 2.06 (10/12) ground wires. The standard for equipment, setup and procedure is EN
61000-4-6.

o5

Conducted  Chrl+D
Aukor trl+M

Hew Automative Key Code

Exit

Loading Automotive Module
—

PIAM
IMMUHITY

Generator
GEHERATORE 3030

=

AE EUT
[DEVICE NAME]

iSetups 1 Companents [ Sieiinge

®1S0 11452 - 4 O 1S0 11452 -5

@EBCI 9

() BCI + Curent Probe

Exit

Fig. 5-1 Main window - Automotive

This window contains:
Menu

Diagram window
Function tabs
Setup table
Measure;

akrwd~

Document PMMISEN-71003-2.16 — © NARDA 2017

Automotive III



5.1.1 Automotive option
activation

@TE

" PMM Immunity Suite Rel. 2.06

Open 3

Mew Aukomotive Key Code

Exit

A narda

Safety Test Solutions®

The Automotive section of the Software suite is an optional
feature.

To enable the Automotive test, use the Automotive Key Code tool in the
program.

For further information on software installation refer to the “Installing
the program” chapter.

Click on “File” and choose ”"New Automotive Key code” for running the
Set code utility, so getting the following window:

Instruments name |F'MM3EI3E| L |
Bustype |[RS232 w Comm Port ii°
K.y code

|EI1 2345672901 2345673901 2345672901 23456734 |

1w J [ glose |

Select the proper instrument model, the bus type and eventually the port
for communicating with it, and simply copy the 40 Digit Serial Code in the
Key Code text box, then select Window and select the Try button.

This message appears when the Key code is not valid.

PMMImmunityS uite (%]

L] E Wrong Serial Mumber ID
[ ]

Or it is not the right code for your instrument:
PMM Immunity Suite g'

@ Sarry, Your key code is nok correct! Conkact wour dealer for any questions.

II' Automotive
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@TE

5.2 EN 61000-4-6
Setups

It will be shown the following progress bar indicating the module is being

loaded.

Loading Automotive Module
—

This means also the Key Code has been successfully stored.

Then the module is ready to be used.

To use the Automotive tool, the registered PMM signal generator must be
correctly connected to the PC running the software and switched on.

If the generator is unconnected or switched off the following message
appears:

PMM Immunity Suite

PMM Generator nok Found, Conneck and switch on PMM Generator and retry.

Once Automotive mode is run, the type of setup needs to be chosen.
The program offers:

-1SO 11452-4 with BCI and, in case, Current Probe

- 1SO 11452-5 with Stripline

Setups T Companents T Settings

©1S0 11452 - 4, O1s0 11452 -5

@ ECI

() B C | + Current Probe

Automotive IEI



5.3 Equipment selection
(Components)

A narda
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In this phase you will select the equipment to be used during calibration or
testing. The program divides equipment by type; for your convenience,
drivers from the PMM family can be used. To enable the desired
module, double click the corresponding line (a v will appear next to the
instrument selected).

- Generators: Exampile list of the available field generators

Generators T Fower Meters T Field Meters T Devices T Current Probes T COthers
st | Wame | s swype| B oo Stics | Stniea [ Mk | Moo
W 00rWETO204  |R5232 b 1 0.0039 3000 107 10

STUB3030 USE ¥ ¥ 0.009 3000 -7 10
Pk 3000 Prdtd 3000 R5232 b3 2 0.01 3000 -80 10
Frdrd 3010 Phdtd 3010 USE % % 0.003 1000 107 10

- Power Meter: Lists the available power meters

Generators Power Meters T Field Meters T Devices T Current Probes T Cthers
Sokcied|  Mome | Posion| SN | mustpe | Br |Pomn| ties | Semiea | Mol Marlewe
Moritor | 000'w10317
FPMMEE30 | Forward | 000MwS<1 0302 Use x® x® 0.009 3000 -40 a0
Reverse | 000WESO306
Forward | 00010302
Y 2% PMMEEZ0 Reverse | ONOWE G306 use R R 0.009 3000 -40 a0
Forward FRIM&RY
DUAL BEOO Fieverse | SECTIMDARY R5485 0 3 0.m 1000 -40 27
- Device: Includes all BCl models.
Generatars 1 Pawer Meters 1 Field Meters | Devices|

Selected MHame S/M Type M[IQBE,HBI M[a;Blfn\i’el

b DEWICE MAME Device 5/M | B.C. -30 0

- Current Probes: Shows current probes with the names of their
calibration files.

| Generators T Power Meters T Devices T f Probes

Selected Mame Cal .File
W J3.1_411 3371 411 cpf

- Others: Shows the amplifier,

Generators T Power Meters T Devices T Prabes T Others!

Environment impedance

() 150 ohm ) B0 ahm
Amplifer
Attenuator
Name [PMM 6000N L T 6lae

Automotive
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Additional devices can be added to each of these tables by right-clicking
and selecting Add new.

Generators T Power Meters T Devices T FProbes
B Cornrn. | Start freq. | Stopfreq. | Min level | Maw l2vel
ks Name |Bustpe| oo |00 T | MHe | B | B
DUMMYGEN |GPIB | y— = === | 20000 -100 20
P 2000 Rszaz | 4 T 1000 20 10
PMM 3030RS  |RS232 | : || 2000 107 10
¥ PMM3030USE |USE | ¥ || 2000 107 10
P 3010USE | LISE b || 1000 107 10
Frdbd 3010RS R5232 i CheckDevice 1000 107 10

Immunity Suite - add Generator.

Instruments name

Instr. driver name PRk 3000 v
Bus type [R5232 Comm Portn®| 1
SN

Fragquency range

From 0ot to 3000 MHz
Level limits
From -20 to 10{ dBm

Save LCloze

Devices can also be checked, modified or removed by right-clicking from
the corresponding line:

Generators T Fowear Meters T Devices i
Bus |Comm,| Start freq. | Stop freq.

Selected Mame Bz bipe adar | port iMHz] IMHz|
DUMMY GEN  |GPIE El 01 20000
Pt 3000 R52% | x| 3 0.0 1000
FMM3030RS  RS232 | W | 1 0.009 3000
Vo HIL:S CHRE 0,009 3000
PhM 3010056 | Addnew ¢ ooos 1000
Pt 3010RS Madify 0009 1000

- Remove —

For connecting and setting the COM port of fiber optic
NOTE equipment, see the user manual supplied with the device.

Automotive IEI
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- Modify: changes the properties of the device

Immunity Suite - add Generator

Instruments parme [PMM 3030USE |
Instr. driver name [PrmMa0200 |
Bus type IU 5B w |

Frequency range

From | n.oog| to | 3000] MHz

Level limits

From | 10_? {1} | 1D| dBm
e

It is possible to modify any of the parameters but the name.
- Remove: removes the device and its driver from the list.

- Check Device: makes sure the driver is working and the device is
properly connected. This option is only available for the device selected ().

If the device is connected and the driver has been correctly installed, the
following message will appear:

PMM 3030058

i Driver test.....Driver works correctly
‘-\‘) Device test, ... .Device 0K

This message will appear if the device has not been connected
properly to the work setup

PMM EPE01

Drriver besk... . .Driver works correcthy
Device kest..... Error during Device test

If the driver of the device has not been installed properly, the screen will
show:

PMM3030U PkM 3030058

ODE Diiver nok Found Instruments comunication error is occurred.
Tesk will be sborted

We recommend performing a device check before starting the
calibration phase or immunity test. In any case, before calibration or
testing, the program runs an automatic check and reports any errors as
described above.

Automotive
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5.4 Diagram window The diagram window shows the setup to be followed on the basis of

the equipment selected.

i

* PMM Immunity Suite Rel. 2.06 (10/12) - [Automotive] (=13
T8 Fle View - 8/x
AlE
Setup table Measure
Generatar
Frequency
80.000
Level
[ ] —
Generator [ RF 1 WOD
Measures
Apiier [
[_Prmcooon | :
Crmmsooon I "5y copier
Forward
* —_—
AE BCI EUT Heverse
Device
[DEVICE NAHE]
[ Measure ]
Setups Components Settings
Generators T Fowar Meters T Devices T CurrantPrnhesT Others Start Test Pause
Bus | Comm, Stop freq, | Minlevel
Selected | Name | Bus ype | Lt | =000 o
V. GENERATORE 3090 % 07
STUB3030 X % 07 Stalus
MM 3000 X[ 2 80 Status
Phib 3010 X | % 107
[ Exit

The selected devices (V) are shown at the bottom of the pane.

In addition to using the Components tab, you can move from one type of
equipment to another by clicking the label with the device's name

| PMM 3030USE

| in the diagram window

Automotive
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5.5 Settings
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After performing the setup shown in the diagram window, the calibration
test parameters need to be set using the Measure tab:

Setups T Cormponents T Settings ]
Measure T Break points T Charts
Frequency Lirnit narme I odulation
Start MHz |Default | E] Type
Stop MHz Power limit Factor | 4] x Depth %
Step MHz Peak conservation
Fultisean
[ Step percent Dwell Time ms

In the limit box there is also the choice for the Peak conservation. This is
useful to satisfy those regulations requiring that under the condition of
amplitude modulated signals the peak level must be the same of the
unmodulated ones used for system calibration. It works both for AM and
Pulse modulations.

All the modulation types, most common in the standards, are available

depending on the model of the generator in use.

The Multiscan feature allows you to modify measurement parameters
within a given frequency range.

PMM MULTISCAN Setup
MultiScan Options

St [Stop’ (St DWAIL. | CMGdumboRT] Dapinl. STkl Mame] | TV

MHz MHz 4 mSec = ¥im

C 1| C 3 1w = B
| e | e =l = =
C | C /) i N
I . Sl Sl
[ o B e -
[ | S
C 1 I ) =) N
[ o B Bl

Exit

Automotive
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With the Break Points tab, you can set the frequencies at which
measurement will be temporarily suspended to allow a change in setup.

Measure T T Chatts
| Freq.MHz | Comment
st |[ 2 [ Carba Arplficatoe
Stop 2 | | .32 | | Cambia &mplificatore
[ Ston3 || | |
[ Stop4 || ||
Csons ][ I

Each time the stop frequency is reached, a message will display the
scheduled action.

Break point 2 @

. \
‘-!}) Cambia Amplificatare

The break points are shown as vertical stripes in the graph.
Click OK to continue measuring.

The Charts tab allows visual modifications to suit your preferences.
For each element, click on the color shown, and change it using the
Windows color box if desired.

In this tab, you can also move the reference level along the y-axis (+ and -
buttons), or change the power level and range (in dBm), the voltage (in V)
and the current (in mA).

Break points

Colot [ Trace
C [ Generator [ [ Forward PW
Lirsor

Color [ [ Maoniton B [JReversePM

Measure T Break points T Charts!
Graph type Chart Reference position ReterenceRange dBm
Linear BackColor 1 Valie| 0}dBin Range [100 + B
+ i 1
Grid Color (| [:] ¥

Automotive
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5.6 Settings management For each new session, the default file CondDefault.tsc is loaded. To avoid

Open setting

Save setting
Save setting as...

Display

Exit:

having to re-enter preferred settings, they can be saved in a single .tsc file:

| The command File -> Save setting overwrites the file in use. If no file was

bl i :
| called up when the program was opened, the default file will be
Ctrl+5 overwritten:
ctr+a | The following message will appear
PMMImmunitySuite
Chrl+s
L3
\:!.‘) The settings file will be changed, are you sure?
Si | Mo
Choose YES to overwrite the file in use. Choose NO to cancel the
operation and return to the main window.
File -> Save setting as... Enter the file name assigned to the work
session and press Save.
Mome file: |Settings-.-'1‘-.uh:|mcutive V| [ Salva ]
Salva come: |.-'1'-.ut|:|m-:|tive Settings Files [*.tza) V| [ Annulla ]
The file can be called up at any time with the command File -> Open
setting.
Automotive Immunity Settings File Browsing && Opening
Cerca in: |l'f}\-"ar v| ¢ N5
), AutoDefault. T54
i :} ﬁutu:urru:uti'-.-'e.t::a
Docurmenti
recenti
il
Desktop
Documenti
Rizorze del
computer MHome file: |Aut0m0tive.tsa V| I Apri ]
.}B Tipo file: |.&utomotive Settings Files [ tza) v| l Annulla ]
B ;:Ii il [ &pri it z0la lettura
File -> Display -> Default colors is used to restore the original display.
Automotive
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5.7 System calibration You can now calculate the levels assigned to the generator in order to
have a constant voltage within the chosen frequency range.

Arrange the setup as shown in the graph:

* PMM Immunity Suite Rel. 2.06 (10/12) - [Automotive] =3
T8 File  view NI
RIC|H|&
Setup table Measure
(O Edit table
PRI
IMMUIITY
SUITE |tab_DefauIt
Table Automatic DEVICE=DEVICE NAME
—————
Generator
Generator
Amplifer (] | ______ MHz |
-40 dB -40 dB
[_Pamsooon | ;
[_pwmcovon ] “prp coner o dBm |
PMMEEI0 Mari
anitar
00010317 ® | mA
: i | |
BCI ﬂ_ Farward
| u Nl
H]]]} Device ® dBm |
DEVICE NAME] Feverse
o dBm |
Setups T Components T Settings
@ 1S0 11452 - 4 O 1S0 11452 -5
@ EBCI
Status
) B LI + Current Probe
[ Exit
5.7.1 Setup table There are different ways to create the table:

- Automatically (select Make automatic table)

- By adapting the automatically created table to the instrumentation
used (select Edit table)

- By completing the entire table manually (select Edit table)

Automotive IEI



5.7.1.1 Automatic table
creation
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To create a table automatically:

- Select Make automatic table

" Edit tabls ) Make automatic table

D , assign a name to the table and press Save.

- Select

Marme file: tab, Default 54T v

Salva come: Automotive BCI T able Files [*.44T) w Anrulla

If an existing table is selected, the following message will appear:

Automotive Immunity Settings File Browsing & Saving IE|

Sastituirla?

"j C:AProgrammitPM Immunity Suikelyarisubomotive. tsa esiske gid,
L

Choose YES to overwrite the table.
Choose NO to cancel the operation and return to the main window.

- A comment can be added, if desired.
[T able Automatic DEWICE=F-120

- Press Start test, then Abort test if you wish to terminate the process at
any time.

[ Start Test ‘ N [ Abort Test l

A Pause button is also available, and becomes Continue to resume the
process.

[ FPauze l N [ Continue |

IE' Automotive
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The Generator window shows the level (in dBm) entered by the
generator, at a given frequency (in MHz), to generate the voltage

required.
Generator B
| 3.4461 MHz |
o 2.3 dBm |

The color of the dot corresponds to the color of the line on the graph.

The voltage applied will be shown in the Power Meter window.
Fower Meter Power Meter

®| 1004V | G

Values outside the selected tolerance will be shown in red; the
generator will adjust the level to bring the voltage back into range. The
color of the dot corresponds to the color of the line on the graph.

During the work session, the generator level and voltage within the
frequency range selected will be shown as a graph.

40,00 14.0

30.00 13.0

12.0

i, S 11.0

10.00 J oV
i .
0.00 w e = R

10,00 30

dBm

-20.00 8.0

-30.00 7.0
40,00 ED
R0.00 5.0
OO0 40
015 201 401 B0 801 1009 1201 140.0 1600 180.0 200.0
MHz

Wait for the calibration to finish.

L]
“:!J) Calibration Finished

The Status window shows each operation performed by the program
during the calibration phase.

Frequency Sent

Press the Exit button to leave Conducted mode (the button is deactivated
during the calibration phase).

Exit l

Automotive IEI
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5.7.1.2 Manual table You may also fill in the entire table manually.
creation

' pMM Imunity Suite - Conducted

Mone Measure

Freq.[MHZ] Level [dBm] =
0.1500)s e (=) Edit table

DR
01630e Modify

01545e - r
----- [ o] 2

01581
----- [ FilTable | | ClearTable ]

Setup table

3

01577
01532
01608
01624
0164
01657
01674
01630
01707
01724
01741
01753
01776
01734
01g2
01830
01843

..... Diizk.

I Load Browse ‘

[ Save | [ Erase |

..... Table information

..... Tahle Name None—|
""" Start [ .1500 MHz]
Stop m:
----- Step L 1004

Level [ 10.0 V|

Setups T Companents T Settings

@ |EC 61000-4-6

() COM/Clamp

(% Clamp + Current probe

[ Exit

Check the information in Setups, Components and Settings.
Go to Setup table -> Edit table.

Select the desired cell, type in the value, and confirm by pressing ENTER.

Freq.[MHZ) Level [dBm]
0. 1500

01515 i
0.1530
0.1545
01561
0.15%7
01592
01608
01624
01641
01657

01674
n1ean

Automotive
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The amount entered can be deleted by clicking Remove.

b adify

I Fill T able

I [ Clear Table |

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

The Clear Table command
command must be confirmed.

Freq[MHZ] Level [dBm) Freq [MHZ) Lewel [dB )
01900 10.2 R
01575)s - 01575 103
01654/ - 01654e 104
01736|e - 01736 e 105
01823 - n1823]e 106
0191de - 0i94ls 07
0201018 - 0z0i0je 107
02111je - nz111]e 108
022168 - 02216|e 109
02327|8 - 0z327s 110
Oza4dle - ozadals 411
02566)8 0Z566(e 112
0z634e - 0ZE3dls 113
nzg2g)e nzazals 114
02970)e - nzo7je 115
oagle ozllels 116
03z7dle 03274ls 116
0343 nz43[e 117
nzeinje - 0z6i0je 118
03730 - oz7a0fs 119
nage0je 03%0js 120
0.4000]v 121 L odooaly 21

deletes all of the values entered. The

Freq.[MHZ] Level [dBm)
oaEmn)y a0z
0I5/ a0z
0Iesdy a0z
073 02
oiezEly a0z
FREE G
o200y 0.2
3212115 . 102 ? Are You Sure you
. " ;
0.2327|e warik ko Clear TABLE
0.2443]e
0.2566| @
0.26%4]s K | annulla
0.2626|e

The Table information pane displays the main measurement settings:

Table infarmation

Table Name  [None |
| .1500 MHz|

Start
Stop
Step

Lewvel

| 200.0000 MHz |

1.00 %)
T

Automotive
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Once all values have been entered, click Save, then type in the name of
the table and click Save again.

Disk,

I Load Browse l

[ Save l [ Eraze l

Nome file: Calbration-table 44T v [ sava |
Salva come: |Ta|:u|e Files [*.441) v|[ Annulla ]

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Save FILE Table as

' C:\ProgrammitPMM Immunity Suited Calibrations! Calibration-table, 34T esiste qgia,
e 4 Sostituirlo?

s =]

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm the

command.
ERASE FILE TABLE

Cercain: | |5 Calibrations

Calibration, 44T

Calibration-table.A4T

B

Documenti
recenti

by |
it

Desktop

)
o =]
b, ]
1 = 3
; =] ;
@ »
=

Rizarse del
computer | Nome file: |Caliration-table 44T v aei ]

:V_ll Annulla ]

= Tipo file: | Tahble Files [*.A41)

[ &priin zola lettura

Rizorse di rete

Calibration-table.A4T [

Are You Sure you

x_:-f/ warlt to ERASE IT
FR.OM Disk 7

[ Ok l [ Annulla

Automotive
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5.7.1.3 Modifying an
existing table

' PMM Immunity Suite Rel. 2.06 (10/12) - [Automotive] =13
T File View HEE
B |
Calibration-table Setup table Measure
Freq [MHZ] Level [dBm] -
0.090(v o5 () Edit table () Make automatic table
0.091 v 28
0.092)y -2.8 tadify
0.093)v 28
0.054|v 2.8 [ Remaove l |E |
g'ggg $ gg [ Fil T able ] [ Clear Table ]
0.096]v -2.8
0.057v 28 Disk
0.098 28
0099 :: BT [ Load Browse l
0100y 28
oioi)y 28 [ s | [ Eme |
0102y 28
0103 2.8 T able information
0104y 28
DA0E|v 28 Table Name Calibration-tabl|
0107y -28 Start 0.090 MHz
0108y 28
0.109(y 2.8 Stop 400.000 MHz
onaly 28 Step
01|y 28
TRRE 4 EX] Level 10.0 V
CHIE T — T
T able Automatic DEYICE=F-120
Setups T Components T Settings ]
Measure T Break points T Charts

Frequency Limit name

Stat [ 0.090/MHz  [Defaut |[;)  DwelTime ms

Stop 400.000 | MHz Power limit Factor x

Step %o Madulation :

Type |Int AM 1KHz v|  Muliscan [ Exit
Step percent Depth %

An existing table can be adapted to the instrumentation used.
Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Automotive 5-17
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Call up a previously created table by clicking Load_Browse, then
selecting the table and clicking Open.

Dizk

I Load Browse l

[ se || e |

Table File Browsing & Opening

Cercair: | I Calibrations vi e Bl
B § Calibration. 44T
£ [ calibration-tabls. 44T
Documenti
recenti
F’%%
Desktop
Documenti
=1 ]
Rizorze del ; ,
computer  Mome file: | Calibration table. 44T | ami |
& Tipo file: | T able Files [*.A4t) vi l Annulla ]
e [ &pri it z0la lettura

Select the desired cell, click Remove, type in the new value, and
confirm by pressing ENTER.

table 10y
Freq.[MHZ] Level [dBm)

oiso0)y 28
Di5I5lY 2.8 I
D153y 28
01648 28
DisElY 28
i Y
01652V 28 b clifys
G T P -
nig24| 28 [ Remave l MRS |
T T p:
L]y 28 [ Fill T able ] | Clear Table ]
01674 28
mAcanh.s =l

Automotive
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To delete all data, select Clear Table and confirm.

2 Are You Sure you
m‘/ wanit ko Clear TAELE 7

ok | annulla |

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

table 150400 table 150400

Freq(MHZ) | Level [dBm| || Fiea(MHZ] | Level[dEm] ||
o150V 102 N EET CELE N
057 102 01575y 0z
0IEs4Y 102 01Es4|y 07
0i7V 102 01736 0z
0.1823e 0igz3le 04
0.1914e 0igidle 07
0.2010| e Dooinje 0@
02111 e 02il|e iz
0o21ElY 114 02216 1.4
namy 114 0237y 14
nzaa3y 114 02483y 14
0O5ER|V 114 075EE|¢ 1.4
ooead|v 114 02654y 1.4
nzemlvy 114 02828y 14
nesinly 114 027y 14
gatialy 114 TR R
nazaly 21 naz7aly dzd
nadzsly a2 D3|y 21
DIy 121 oIy 21
0Emy 2] oEEnly dzd
gase0ly 21 0aga0ly  d2d
oAy 121 Ed gamnly 21 Bd

The Table information pane displays the main measurement settings.

Table infarmation

Table Name  [None |
Start 1500 Wiz

Stop | 200.0000 MHz|
Step 1.00 %
Level j 10.0 V|

Automotive
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Once all values have been entered, click Save, then type in the name of
the table and click Save again.

Disk,

I Load Browse l

[ Save l [ Eraze l
Nome file: Calbration-table 44T v [ sava |
Salva come: |Ta|:u|e Files [*.441) v|[ Annulla ]

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Sawve FILE Table as

"ﬂ_., A ProgrammitPRM Irnmrunity SuibelCalibrationshCalibration-table. A4 T esiste qid.
L Sostituirlo?

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm

the command.

ERASE FILE TABLE

Cerca in: |lﬂ Calibrations v| ¢ 1} s i

Calibration, 44T

Calibration-table.A4T

B

Documenti
recenti

by |
it

Desktop

)
o =]
b, ]
1 = 3
; =] ;
@ »
=

Rizarse del
computer | Nome file: |Caliration-table 44T v aei ]

e Tipa file: | Table Files [*441) vl [ Annula |
[ &priin zola lettura

Rizorse di rete

Calibration-table.A4T [X]

9P Are You Sure vou
x_-;/ warlt to ERASE IT
FROM Disk, 7

[ Ok l [ Annulla

Automotive
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5.8 Immunity test WITH If a bulk current injector is used, the AE configuration must present
Impedance common-mode impedance (consult EMC regulations for further details).
Requirements
(Setups) If the impedance requirements are satisfied, select BCI.

PN

IMMUHITY
SUITE

Generator

GENERATORE 3030 | [}
[]

Amplifer
PILAGH 00 [ ]

AE EUT
L EVICE MARME]
Setups T Components T Settings
®1S0 11452 -4 150 11452 -5

@ ECI

{3 B C1 + Currert Probe

Automotive IEI



5.8.1 Starting the test

' pMM Imunity Suite - Conducted

Go to Measure.

7 N
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EEX]

Setup table Measure
40.00 Generator
000 | Frequency
L1 LI
«-3977 MHz
20.00 el
10.00 ® -2.8 dBm
0o =
&:‘:; -10.00 Wbasures
2000 .
3000
4000
000
000 I
015 201 401 B0 an 1 1007 1207 1400 1BDO 1800 2000 e
MHz
} ¥ H Abort Test H Pause
F O e
= R
Status
N | Forward P [N Sending Level
| it . werse il 1 Exit
Click Start Test.
If no setup table has been selected, the following message will appear:
PMMImmunitySuite
Mo Calibration Table selected, please select it befare to continue.
Click OK, then select the table and confirm with Open.
Table File Browsing & Opening
Cerca in: |lj Calibrations v| €] ? o .
{2 £ Calibration. &
2 Calibration-table. 44T
[ ocumenti
recenti
(i
Desktop
=/
D ocumenti
Risorse del
computer | Nome file: | Calbration.44T vl [ 2o ]
‘g Tipa fle: [ Table Files [* 44 v| [ Ao ]
Hisors.e ::Ii Al [ &priin zola lettura
[ 522 ]| Automotive
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Otherwise the message that appears is as follows:
PMMImmunitySuite

Selected Calibration Table is "Calibration-table”, would vou like to change it?

(s I w

Choose Yes to view the Table File Browsing & Opening window and
select a different table. Choose No to use the file shown and open the
following data entry window (the date and time are entered
automatically).

Immunity Suite - Info & Log

Test Report

Date  |02112:2009 | Time  |1239.18 |

Title | [[.] Company | |
EULT. | | sm| |
Ambient

Temperature | | Humidity | |% At |:r|essu|ei imh
Table table_10v Operator |

[Note:

Done

Enter the name of the immunity test.

Title || | E]

Click [:] and enter the test name, then Save.

Marne file: El:lnleJE:lEl:l bt 10 V| | Salva |

Salva caome; 1Te:-:t Files [* kat] Lj Annla

If an existing test is selected, a confirmation message will appear.

Save File Report as

' CiAPragrammiiPMM Immunity: Suite\RepartsiConducted_test_G0_90.kxt esiste gid.
. Sostituirlo?

Fill in the fields Company, E.U.T., S/IN, Temperature, Humidity, Atm.
Pressure, Operator and Note.

Automotive IEI
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7 N

The data entry window is now complete:
Test Report

Time |_15_3529_i

[[.] Company [Narda STS |

| s |[FrROD15A231 |

Title | Conducted_test_10v.tdt

E.LLT. [Nome del dispositiva sotta test
Ambient

Table (table_10v |

Note:

Confirm with Done to start the immunity test.
If an existing test is selected, a confirmation message will appear:

PMMImmunitySuite

AN

whould you like to cancel the old file?
If MO the mew data will be append
to the end of existing file:

J [

Si Mo

Choose Yes to overwrite the data with the test in course.

Choose No to append the new data.

EEX

Setup table Measure
40.00 Generator
- [ Frequency
30,00
54.2432 MHz
20.00 Level
S ® -1.5 dBm
0.00
— | RF
£ qnon
m Measures
20.00
000 ™
-40.00
-50.00
I..
H0.00
018 201 40.1 B0 80.1 1009 1201 140.0 1E0D 1800 200.0 [ T ]
MHz
| Abort Test l [ Pause
=
=
Statuz
Sending Level
¢
= =2 A Range 100mA v | Exit
Automotive
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During the test, the Generator window shows the level extrapolated
from the setup table and used by the generator to obtain the required
voltage.

The color of the dot corresponds to the color of the line on the graph
Frequency
6101 MHz

Level

@ -2.8 dBm

During the test, the frequency range and generator level will be shown in
graph form.

40,00

0o

20,00

1000

000

-10.00

dBm

-20.00

3000

-40.00

0,00

-E0.00
015 201 401 801 801 01 1201 140.0 1E0.0 1800 2000

MHz

At any time, the test can be terminated by clicking the Abort Test button
and confirming:

ABORT TEST

b d Sure you wank
'n.:/ Ea FINISH?

(0] 4 Annullz |

Automotive IEI
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The Pause button can also be used at any time to stop the test
momentarily (the generator is set to RF OFF).

In this state, an earlier situation can be recreated or a later one can be
simulated; click the RF button (the generator is set to RF ON), adjust the
frequency and level with the arrows, and click Measure to display the

voltage.
Ge:ner_atol .
Frequency
.8306 MHz (3]
Lewvel
e -28dBm |5
[ RF l
Measures
[ Measure ]

Each time the Pause button is clicked, the following window will

appear:
40.00 Immunity Suite - Info & Log
Test Log
2 Time
20.00 Frequency
Lewvel
10.00
I Monitor
0.00 Forward
—
o Reverse
= 1000
= Mote:
=
-20.00
-30.00
-40.00
50,00
000
01s 2 401 50,1 /11 11 I =1 A R [ save || Ciose |
.

hMiH=

Automotive
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Pressing Save assigns a marker to the current position for future
reference. At the end of the test, the saved information can be viewed
simply by hovering the cursor over the marker.

L, () O [ [ (&1
I%rkernﬂ [

Fred.=138.2148 MHz
Level = - 1.8 dBm

In'ulanitq:-r = e
——Fwid = —
——Rev= - —
—
—
The button will now read Continue to resume the test.
40,00 0 6
30.00
20,00
1000
0.00 —
5 000
-20.00
30,00
-40.00
B0
-B0.00
015 2000 401 B a0 100.1 1207 1400 1600 1800 2000
MHz

The status window shows each operation performed by the software
during the test.
Frequency Sent

The end of the immunity test will be announced with the message:

X]

L]
| J Test Finished

Automotive



@

A narda

Safety Test Solutions

When the test is over, the graph can be saved in .bmp format by right-
clicking anywhere in the graph and selecting Save bmp.

40,00 0 @

3000

20,00

1000

0.00

1000

i jo

-30.00

dBm

-40.00

H0.00

G000
015 207 401 E0.1 an1 1001 1201 140.0 TEDD 1B0.0 2000

MHz

In the next window, assign a name to the graph and press Save.

Marme file: loraph_test &40 V| [ Salva ]

Salva come:; !bitmap [".brmp) v|[ Arinulla ]

The saved graph can be inserted into a text file using the Editor feature
(see the Editor section for details).

Press the Exit button to leave the immunity test..

[ Exit |

Automotive
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5.9 Immunity test If the impedance requirements cannot be met, the current produced by
WITHOUT impedance the induced voltage must be checked using a supplementary probe
requirements (Setups) placed between the Bulk Current Injector and the EUT (see EMC

regulations for further details).
For this configuration, select BCI + Current probe.

PV
IMRMUHITY
SUITE

———
FPMMEEI0
0004210302 [000wEB0308

Generatar

GEHERATORE 3030 [

Amplifer [
-40de
a

-40 dB
| RS UL

2PMMEEI0
0010317

AE EUT
[DEVICE MaME] [ TIPICAL |
Setups T Compaonents T Settings
®1S0 11452 -4 150 11452 -5

O EBCI

(33 B C 1 + Current Probe

This procedure provides only significant differences with respect to the
previous test.

Automotive
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5.9.1 Monitoring the Go to Measure.
current

CIE)X]

' pMM Imunity Suite - Condl.Rted

Setup table Measure
40.00 100.0 Geherator
i Frequency
30.00 0.0
1624 MHz
20,00 ea0 Level
i 56 ® -2.8 dBm
0.00 800 | s
£ Jqom 5003
m | Messues 5
-20.00 ana Moritor
* 2.03 mA
2000 a0 -
4000 200
0,00 160 e
000 oo J
015 201 401 501 a1 001 1200 1400 1ED0 1800 2000 [ FrP— |
MHz

Abort Test l [ Pause

Status
Sending Level

[ Exit |

The example below shows the current and the generator level during a test
in which the current limit is exceeded and then brought back into range by
the software. The correct generator levels will be saved and used during
the second sweep.

4000 | 1000

3000 I 50

2000 800

10.00 700

D0 A J Gl
— / \ i

-
E oo 503
@ / ! e
¥ |

2000 a0

7 ) i
3000 00
i |
4000 !/ 2040
_(J"'
50,00 e \L/ 100
2
—
£0.00 00
015z 401 01 801 1001 1200 1400 1BDD 1800 2000
NMHz

Automotive
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5.9.2 Second Sweep When the process has finished, you can save the new table calculated
during the first sweep. If no name is assigned, the program will use the
name of the previous table and add " modified" (e.g. tabc_
10v_modified.fct).

After the file is saved, a prompt will appear to conduct a second sweep
with the new table.

b i
\_‘./ Would vou like to start the second sweep

= I w ]

The graph below shows the new generator levels applied during the second

sweep.
Setup table Me
4000 100.0 Generator
. . Frequency
3000 300
200.0000 MH
2000 200 Level
10,00 700 L J 1.3 dBm
0o E= = o [ [ REGFF
— i e ;
£ 000 5003
m | Messues
2000 100 Manitor
L J —
-30.00 00
40.00 200
BO.00 100
80,00 0o : :
015 201 a1 BOT E0l 1001 1201 1400 E00 1800 2000 [ ———
MHz
Setups T Components T Settings 1
P3
Measure T Break points T Charts 1 Start Test ‘ i
Frarh hire Chiart Fieteranes nnsi tirms Flafersneat Banns dim bl
< | >

At the end of the test, the table will appear with the new values marked
by a red dot.
L1

Bhd |V -T2
017361V 102
01823 |m -10.4
01314 |= 1007
02010 -10.49
02111 |m 11.2
At | i1 4

Automotive IEI
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6 — PMM Immunity Test
Editor

6.1 Introduction to Editor This section explains how to view and correctly interpret the data acquired
by the immunity tests.

Start Editor by clicking the button o

File. F"“ "=earch

i1 )

1
i
&

EEG a8 £ U 9 WislUnicode s ~1 | (8 ]| = | (B

MHUM 11.43 1741142009

Fig. 6-1 Main window — Editor
This window contains:
1. Menu
2. Command bar

3. Main window

Document PMMISEN-71003-2.16 — © NARDA 2017

Editor



A narda

Safety Test Solutions®

6.2 Creating or opening  To create a new report, select File -> New
a report

To open an existing report, select File -> Open or use the button
on the command bar.

Edit  Search
DlEt Chrl4p

CIran Rl

=8 Edit  Search
e CErl+

CipEn el
S Thells

In the window, select the file in the Reports folder and click Open.

Apri @

Cerza in: |'-';}Fleports _.J . = B

[£] conducted_test_s0_90
.-J [ )radiated: tes
Recent i) stz
[ tabe_1017_11_2009 14_53_36.wHL
[ kable_150_400 17_11_2009 14_57_39,WHL

=

d

Desktop

.LMI

@

Rizorse del
computer

-

Nare fie; |Padiated_test_50_30 | Ap

Risorse ditete  Tino fle; | Files 7 7) x| Al

I &priin zola letira

The file will appear in the main window.

* Editor [C:\Programmi\PMM Immunity Suite\Raports\Radiated test BO 90.txt]

EEHG A LMD B r U § & | [CoierNew = [es == | (9] &

EN £1000-04-032 - PMMYM Inunounity Suite A~

Date: 1671172003
Time: 15.55.59

Company name:

E.U.T. name: Home del dispositive sotta test
E.U.T. $/N: FROOLEAZZL

Operator: Rossi Mario

Test equipment:

Generator: Harda-STS PMM 30300SE
Power Meter: Narda-ST2 DUAL 6520
Field Meter: Narda-STS PMM EPGOL

Awbient data:
Temperature: ZZ
Humidity: 50%
Atm. pressure: 100mb

Note:

Test settings:
Start Frequency: S0 MHz
Stop Fregquency: 90 MHz
Step Frequency: 1 %
Modulation type: Inc AM 1FHz
Modulation depth: 20 %
Limit: 10V m
Tollerance: 1V/m
Dwell time: 1 =
Calibration Table name: cable 20_30

Event log n°l - Time: 15.56.47 - Elapsed time: 00:00:4%
Generator Frequency: 81.608000 MHz
Generator Level: -37.2 dBu v

Caps NUM HINS 1234 18/11/2003

Editor
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6.3 Report format Below is an example of the report generated at the end of the immunity test:
R . . . = . " |
Editor [C:AProgrammi\PMM Immunity Suite\Reports\Radiated_test BO0_90.txt] - :'—_. ]
| B 9L B rUsE ICnurierNew _:J J8.2 _:J == El
EN &£l000-04-03 = FPHM Inmmuhity Suite
Date: 1671172009
Time: 15.85_5%
Conpany hame:
E.U.T. name: MNome del dispositiwo sobto test
E.U.T. 5/N: FROOLEAZF31
Operator: Rossi Mario
Test aquipment:
Generator: Narda-5T2 MM 30301T5E
DPower Meter: Narda-5T2 DUAL &&30
Field Meter: MNarda-STE FMIM EFPe0l
Imbient data: .
Tenperature: IZE
Humidity: 50% F
Atm. pressure: 100mb
Note:
Test settings:
Start Frecquency: 80 MHz
Stop Fredquency: 50 MH=z
Step Fredquency: 1 %
Modulation type: Int AM 1KH=
Modulation depth: 20 %
Limit: 10W/m
Tollerance: 1V m
Dorell time: 1 s
Calibration Table name: table 20 20
Event log n"l - Time: 15.56.47 - Elapsed time: 00:00:49
Generator Fregquency: 81.&603000 MH=
Generator Lewel: -37.Z dBm
Forward Level: 5.1 dBm
Dewverse Lewel: -10.4 dBm
Note:
Event log n®Z - Time: 15.55.14 - Elapsed time: 00:0Z:15 .
Generator Fredgquency: 84 921610 MH= i
Generator Lewel: -37_2 dEm
Forward Lewel: 5.5 dEm y
Bewverse Lewvel: -10.EZ dBm
HNote:
Event log n®3 - Time: 15.58 25 - Elapsed time: 00:0Z:2&
Generator Fregquency: S88.3e3770 MH=
Generator Lewel: -37.32 dBm
Forward Level: 2.2 dBm
Reverse Lewvel: -10.4 dEm
Note:
ML 1213

The format is highly user-friendly and clearly presents all of the information
gathered during the test. The information in bracket 1 concerns the
equipment under test, the instrumentation used and the ambient data.
The rest includes all events that interrupted the test; they are listed in
chronological order along with the data acquired at the time of the
interruption.

Editor
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The report can be adapted to your needs through a series of
commands:

- To modify the contents.
Search

IInda Chrl+2

iZuk Chr
Paste CEr+P
Copy Ckrl4+12
Clear Ckrl+D

Selact all ! &If I—:J D

The Edit menu allows you to Copy, Cut, Paste, and Clear text.
The entire text can be selected with the Select All command.
In case of error, the Undo feature will reverse unwanted modifications.

- To add images:

Click the - .-J. icon on the command bar to insert .bmp images into the
report.

Cercain; |_; Reports _"J - I::F -

el [“iGrafico test B0 90;
Recent

F—
|

E;
Deskiop

)

Documenti

Rizorse del
camputer

‘;} Marne file: |Grafico_test_BD_SD L] Apri |
Rizorse ditete  Tipo file: |bitmap [ brap) ::J Annulla

I~ Apiin sola lettura

Select the file and press Open.
- - To change text and color formatting.

Select the part to be modified (by holding down the left mouse button) or
the entire report (Edit ->Select All, then change the appearance of
the text using the buttons and dropdown menus on the command
bar:

B 7 U & & | |@biallnicodeMS  «] 8 «| =
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6.5 Saving the report

=8 Edit Search

Save Chrl+5
Save As  Chrl+A

@TE

6.6 Printing the report

Edit. Search
I Frint ChiT

Frik TRl
P
=)

6.7 Leaving Editor

Edit  Search
ExlE

To save the report, click:
- Save: to overwrite the document in use, or.

- Save As : to save in one of three formats:
e Calibration log Files (*.WHL)

o Text files (*.txt)

e Rich Text Files (*.rtf)

All files saved in .txt can be viewed by other applications. In Word or
Excel, search for the report using the Open file command with File

type: All files (*.*). Select the report from your folders and click
Open.

L
Print the report by clicking File -> Print or the (= button on the
command bar

Close the file with File -> Exit or the EJ button on the command
bar.

Editor
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Mod. 18-1
Caro cliente
grazie per aver acquistato un prodotto NARDA! Sei in possesso di uno strumento che per molti anni ti garantira un’alta qualita di servizio. NARDA riconosce
I'importanza del Cliente come ragione di esistenza; ciascun commento e suggerimento, sottoposto all'attenzione della nostra organizzazione, € tenuto in grande
considerazione. La nostra qualita e alla ricerca del miglioramento continuo. Se uno dei Suoi strumenti NARDA necessita di riparazione o calibrazione, puo
aiutarci a servirla piu efficacemente compilando questa scheda e accludendola all'apparecchio.
Tuttavia, anche questo prodotto diventera obsoleto. In questo caso, ti ricordiamo che lo smaltimento dell'apparecchiatura deve essere fatto in conformita con i
regolamenti locali. Questo prodotto & conforme alle direttive WEEE dell’'Unione Europea (2002/96/EC) ed appartiene alla categoria 9 (strumenti di controllo). Lo
smaltimento, in un ambiente adeguato, puo avvenire anche attraverso la restituzione del prodotto alla NARDA senza sostenere alcuna spesa. Pud ottenere
ulteriori informazioni contattando i venditori NARDA o visitando il nostro sito Web www.narda-sts.it.

Dear Customer

thank you for purchasing a NARDA product! You now own a high-quality instrument that will give you many years of reliable service. NARDA recognizes the
importance of the Customer as reason of existence; in this view, any comment and suggestion you would like to submit to the attention of our service
organization is kept in great consideration. Moreover, we are continuously improving our quality, but we know this is a never ending process. We would be glad if
our present efforts are pleasing you. Should one of your pieces of NARDA equipment need servicing you can help us serve you more effectively filling out this
card and enclosing it with the product.

Nevertheless, even this product will eventually become obsolete. When that time comes, please remember that electronic equipment must be disposed of in
accordance with local regulations. This product conforms to the WEEE Directive of the European Union

(2002/96/EC) and belongs to Category 9 (Monitoring and Control Instruments). You can return the instrument to us free of charge for proper environment friendly
disposal. You can obtain further information from your local NARDA Sales Partner or by visiting our website at www.narda-sts.it.

M Servizio richiesto: M Service needed:

O Solo taratura U Riparazione [ Riparazione & Taratura U] Taratura SIT U1 Altro:
[ Calibration only [ Repair [] Repair & Calibration [ Certified Calibration (1 Other:
Ditta:

Company:

Indirizzo:

Address:

Persona da contattare: Telefono:

Technical contact person: Phone n.

Modello: Numero di serie:

Equipment model: Serial n.

M Accessori ritornati con I'apparecchiatura: [ Nessuno [ Cavo(i) [ Cavo di alimentazione Altro:
M Accessories returned with unit: 1 None [1 Cable(s) [ Power cable Other:

M Sintomi o problemi osservati: M Observed symptoms / problems:

M Guasto: O Fisso O Intermittente  Sensibilea: O Freddo O Caldo [O Vibrazioni [ Altro
M Failure: [ Continuous [ Intermittent Sensitive to: [ Cold ] Heat I Vibration [ Other

Descrizione del guasto/condizioni di funzionamento:
Failure symptoms/special control settings description:

Se l'unita é parte di un sistema descriverne la configurazione:
If unit is part of system please list other interconnected equipment and system set up:




Suggerimenti / Commenti / Note:
Suggestions / Comments / Note:
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